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The C3Deditor 

Introduction 
The Motion Lab Systems C3Deditor provides everyone with an easy way to 
visualize, edit and manipulate data within the C3D file structure. It allows the user 
complete access to edit and change the data or parameters in any C3D file while 
working within the 32-bit Microsoft windows environment. 

The C3Deditor is a  tool 
that has the ability to read 
and correct many C3D file 
format errors. This allows 
the C3Deditor to open and 
read many C3D files that 
other applications may fail 
to open. 

The C3Deditor is designed to operate on C3D data files that have been created in 
either Floating Point on Integer format. The C3Deditor includes complete support 
for all three Floating Point formats ( INTEL, DEC, or SUN) and can convert 
between any of the different file formats.  Thus data collected on one hardware 
platform can be converted and read in any other supported software environment.  
In addition, the ability to import 3D and analog data directly from a Microsoft 
Excel spreadsheet allows you to construct C3D files from almost any external data 
source and then edit and manipulate the data for access in another environment.  

 

Figure 1 – The C3Deditor with a file open and displaying raw analog data 
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The C3Deditor allows you to quickly view the raw data contained within any C3D 
file – even down to the individual analog samples in each analog channel. Data 
quality can be rapidly determined simply by opening a file and displaying the 
contents. An additional feature highlights 3D data with large residuals so that you 
can quickly locate problem areas within the data collection volume. 

In addition to allowing you to view and edit the data, the C3Deditor can also modify 
the Parameters and Groups contained within all C3D files, and create new group and 
parameter items. The C3Deditor also allows you to edit, add and delete up to 18 
separate events stored in the C3D file header. 

The C3Deditor also 
includes a verification test 
function that can verify that 
the C3D parameters and 
data match a standard set. 

Data filtering and 3D trajectory interpolation are provided as standard features in 
the C3Deditor. You can automatically filter both the analog and 3D data to remove 
noise or unwanted components of the data as well as interpolating the 3D data.  In 
addition the C3Deditor supports the appending or merging of data from two C3D 
files to form a single file.  Multiple C3D files can be opened by the C3Deditor 
which allows Groups and Parameters to be cut, copied and pasted between files. 

Almost all of the operations in the C3Deditor can be run automatically whenever a 
C3D file is opened by using a built in “batch” mode using a simple text file to 
control the “batch” operation.  The standard C3Deditor installation includes 
numerous “batch” file examples – the “batch” feature makes it easy to, for example, 
automatically apply a band-pass filter to the EMG data channels, a low-pass filter to 
the Force data channels, interpolate the 3D data trajectories and add specific 
descriptions analog channels whenever a C3D file is opened. 

C3Deditor Features 
• Display and navigate the complex structure of the C3D file in an easy-

to-understand view with a few mouse clicks. 

• Open several C3D files at once and cut and paste between them. 

• Display any 3D trajectory or analog data value both graphically and 
numerically.  Display every sample of analog data in any channel. 

• Highlight 3D data with high residual values. 

• Edit any part of the C3D file – header, parameters or data.  The 
C3Deditor can even modify, create and delete “locked” parameters! 

• Create, Delete and Modify any parameter or group of parameters. 

• Comprehensive filtering - High Pass, Low Pass, Band Pass and Band 
Stop filters for 3D and analog data. 

• Interpolate 3D data based on length of gaps or residual values. 

• Delete and Fill feature to make quick trajectory repairs to 3D data.  

• Automate repetitive operations with a powerful batch mode to perform 
almost any edit or data operation whenever a C3D file is opened. 

• Verify C3D files – check that your C3D files match the structure and 
data range specifications set by your data collection environment. 

• Generate C3D files in INTEL, DEC and SGI formats and convert files 
between these formats. 

• Save data in Floating Point format for maximum accuracy or Integer 
format for minimum size. 

2  •  The C3Deditor The C3Deditor User Guide 



 

• Import data from Excel into both 3D and analog structures to create 
C3D files from almost any data source. 

• Export data in CSV format that can be read by any spreadsheet. 

Installation 
The Motion Lab Systems C3Deditor is a 32-bit application, written to take full 
advantage of the 32-bit Microsoft Windows 95/98/NT/2000/XP operating systems.  
It is supplied with example data, and a full installation setup and removal program. 

You can use the Windows Add/Remove Programs option in Control Panel to 
install the program from a CD-ROM or you can just run the setup.exe file from 
Explorer. This will install the program on your system together with some sample 
files that you can use to demonstrate and evaluate the program. 

If you accept the default 
options during installation, 
then you will created a 
menu group together with a 
desktop short-cut. 

The installation procedure is simple – when the installation program is started it 
will lead you through a series of displays that identify the program and display the 
license agreement.  When you agree to the license the program will prompt you to 
enter your name and site details together with a license number. If you have not 
purchased a license then you can run in evaluation mode by entering 0000-0000-
0000-0000 as the serial number.  This runs the program in an evaluation mode so 
that you can try out the product before you decide to buy a copy.  If you have 
purchased a copy then enter your license number together with your User Name 
and Organization details exactly as supplied. 

If you are installing the 
C3Deditor as an update to 
an existing installation then 
your current registration 
details will already be filled 
in when the Information 
screen appears.  Do not 
change any of the 
information – just click on 
the Next button to continue. 

 
Figure 2 – The install program prompts for the registration information 

The default installation option for the C3Deditor is to install a typical installation 
which will copy the program and some sample files to your system.  It is 
recommended that you accept the typical installation if you wish to go through the 
tutorial in this manual or use the sample batch files.  You may change the installation 
defaults by selecting a custom installation at this point. 

You will then be asked to select two folders (or directories): 

1. The Applications folder – the C3Deditor and sample files will be 
installed in this directory.  The default is C:\Program Files\MLS\C3Deditor 
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2. The default .C3D directory – this is where the C3Deditor will first start 
looking for C3D files.  The default is C:\ud – you should enter the 
appropriate directory for your system. 

The installation program will then check that there is enough space on your system 
to install the option (typical or custom) that you have selected and will prompt you 
for a program group to place the program in – the default is Gait Lab. 

The C3Deditor will then be installed on your system in the directories that you have 
specified.  If you need to remove the C3Deditor from your system you can either run 
the REMOVE.EXE program that is installed in the C3Deditor application directory or 
use the Add / Remove Software option from the Control Panel.  These options will 
completely remove the C3Deditor and its associated registry information form your 
system. 

Whenever the C3Deditor is used it will display the name of the registered user and 
the site.  The version number of the installed program can be found in the About 
dialog box.  Updates to the program are available from the Motion Lab Systems web 
site and can be downloaded at any time. 

Evaluation mode 
The C3Deditor can run in a limited evaluation mode so that you can try out the 
product before you purchase a copy. In this mode, you will only be able to open and 
edit the sample C3D files that are supplied with the default installation.  In addition 
you get reminder messages that you are running the evaluation version whenever the 
program is run. 

A registered version of the application does not produce these reminder messages 
and allows you to open and modify any C3D file. You can purchase a registration 
key and manual from Motion Lab Systems, Inc. 

 
Figure 3 – The Help - About box 

The C3Deditor retains considerable flexibility in the Evaluation mode and can be 
used for many different purposes within the 100 frame limitation. The evaluation 
mode is intended to allow you to verify that the program functions as required prior 
to purchase.  If you find the C3Deditor useful and continue to use the program in 
Evaluation mode then you should purchase a copy of the program. 
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A registered copy of the C3Deditor will display the Registration details in the Help 
About box, which will state that the C3Deditor is a REGISTERED COPY.  In addition 
your name and registration information will be displayed on the background of the 
C3Deditor whenever there are no files open and when the program is first started. 

Registering an Evaluation copy 
If you have purchased a copy of the C3Deditor after installing the evaluation version 
then you will need to enter the registration information from within the C3Deditor.  
This option is only available when you have an unregistered copy of the program 

If you have not entered any registration information then you can use the Contact Motion Lab Systems, 
Inc  to purchase a software 
registration for the C3Deditor 
– the email address is 

Help 
Register command to enter your Registration Number.  This number must be 
entered exactly as shown on the license together with the User Name and User 
Organization that appears on the software license.  Don’t forget to include any 
punctuation marks or periods.  This information will be stored in the registry on your 
computer and will be used to verify that the program is licensed. 

sales@motion-labs.com or on 
the net at http://www.motion-
labs.com  

 
Figure 4 – Entering Registration information 

Windows NT and Windows 2000 
Some users may have problems registering the software on an NT (or Windows 2000 
Professional) machine and find that they have to enter the registration details every 
time that they run the software unless they log in as "administrator".  This is due to a 
security feature with Windows NT and Windows 2000 where registry values are 
created with permission attributes.  The system administrator, or any user logged in 
with administrator privileges can fix this problem as follows:  

1. Log into the computer with administrator privileges and run 
c:\winnt\system32\regedt32.exe to start the administrator registry 
editor.  

2. Locate the HKEY_LOCAL_MACHINE in the Local Machine window.  

3. Locate the SOFTWARE key and expand it.  

4. Locate the MLS key and highlight it - select the Security option - this 
causes a drop menu to appear with three options - select the 
Permissions option. This will open the Registry Permissions dialog 
window.  
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5. Select the "Everyone" permission (Windows NT) or the "Users" 
permission (Windows 2000) and change it to allow "Full Control" or 
create permission for "Domain Users" with the "Full Control" access 
rights.  

Repeat this operation for the same key in HKEY_CURRENT_USERS.  Note that 
Windows NT and Windows 2000 have slightly different descriptions for the registry 
controls.  When using Windows NT you should select the option to "Replace 
Permissions on Existing Subkeys" while Windows 2000 Professional users should 
select the option to "Allow inheritable permissions from parent to propagate to this 
object" 

 
Figure 5 – The Windows 2000 Professional registry editor 

In all cases that involve editing the Windows registry you should make sure that you 
have a backup of the registry before you attempt any changes.  If in doubt, it is 
recommended that you discuss this operation with the system administrator before 
making any changes.  

Important Warnings 
The C3Deditor allows any user to edit almost any part of the C3D file. It is very 
important that you understand the consequences of editing file structures before you 
attempt to modify them. It is recommended that, at a minimum, you read the section 
on the C3D file format prior to attempting to create, modify or delete any item in the 
C3D parameter header.  Additional information on the C3D file format can be found 
on the Internet at http://www.c3d.org. 

Locked Parameters 
Particular care should be taken when changing LOCKED parameters and, although 
the C3Deditor allows you to edit these, we strongly recommend that you do not 
change them without careful thought.  By default the C3Deditor will be installed 

Improper or careless use of 
the C3Deditor can destroy the 
validity of the data within any 
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C3D file by changing the 
parameters that describe the 
contents of the data file. 

with the ability to edit LOCKED parameters disabled – the editing of LOCKED 
parameters can only be enabled by changing a setting in the operating system 
registry.  Details on enabling this feature are discussed later.   

The LOCKED status of a parameter is set by, and is the responsibility of, the 
application that generates the C3D file.  It is very important to recognize that there is 
no guarantee that the value of an UNLOCKED parameter can be safely changed as 
(at the time of writing) many applications from well known manufacturers fail to 
correctly set the LOCKED status of parameters within their C3D files. 

Please remember to make backups of all important data files before you attempt to 
edit them.  The C3Deditor is a powerful tool but requires caution and knowledge on 
the behalf of the user.  Motion Lab Systems is not responsible for the loss of any data 
caused by the use of the C3Deditor. 

C3D File Validation 
The C3Deditor performs extensive checks of the C3D file structure whenever a C3D 
file is opened and will attempt to read the C3D file contents even when the C3D file 
contains numerous structural and data errors.  This means that you cannot assume 
that a C3D file is formatted correctly just because the C3Deditor opens the file and 
displays the contents.   

Many basic structural errors in C3D files can be corrected by using the C3Deditor to 
rewrite the C3D file in question but other problems such as incorrect parameter 
dimensions or parameter types must be corrected manually as these requirements 
may be specific to various applications.  The C3Deditor includes a useful file 
structure validation tool that allows the structure of individual parameters to be 
tested.
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Tutorial 

C3D Files – An Overview 
Clinical Gait and Biomechanics Laboratories around the world use motion capture 
systems manufactured by several different manufacturers.  Each system often stores 
the data in a different "standard" digital file format. As a result, a user can study a 
single subject with each manufacturers system but comparing results is difficult 
without a common data interchange standard. 

This relative incompatibility of basic information in a laboratory serves to isolate 
each clinical biomechanics laboratory. When laboratories use different motion 
capture systems, they cannot exchange data freely, even within large hospital 
organizations and networks.  Because of this isolation, laboratories have no way to 
share any of the results of their studies or easily submit the lab to peer review 
except with another person using the same data collection system. Each laboratory 
has to either write its own software, or use software that is specific to the format of 
their 3D capture system. 

Some companies have even 
introduced new systems or 
upgraded old equipment so 
that the new data formats 
are incompatible with data 
recorded in the same 
laboratory by an earlier 
version of their own 
software! 

At the root of this problem is the fact that a study performed in one lab is only 
comparable with a similar study in another lab if the two labs use identical 
equipment. We need a "Rosetta stone" that can make data from any manufacturer 
intelligible to any user. It would have to have the following properties: 

• The ability to store 3D and analog data in an unprocessed form. It is not 
essential that data is stored without processing, but the format needs the 
ability to support raw co-ordinate and analog sample data. 

• Preserve information that describes the physical laboratory such as 
EMG channels used, force plate positions, and marker sets etc. 

• Store Trial information relating to the circumstances of the test session 
such as sample rates, filenames, dates, EMG muscles recorded etc. 

• Store Subject information - name, age at trial, with physical parameters 
such as the subjects’ weight and leg length etc. 

• Store calculated analysis results such as gait timing, cycle information 
and related information. 

• Flexibility and compatibility - it must provide the ability to store new 
information without making older data obsolete. 

• A public specification and file format description. 
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Such a tool exists today and has been proved in continuous use over many years. The 
C3D data file format was developed at the National Institutes of Health by Andrew 
Dainis in 1987 and conforms to a public C3D file specification. 

The design of the C3D file format was originally driven by the need for a convenient 
and efficient format to store data. The format stores 3D coordinate and numeric data 
for any measurement trial, together with all the various parameters that describe the 
data, in a single file.  

The ability to store a multitude of information about the data is the feature that sets 
the C3D format apart from every other biomechanics format. Early in the design of 
the C3D format it was realized that it was unlikely that one, ironclad, specification 
would fit every biomechanics need.  As a consequence of this insight, the C3D file 
usually stores within itself, a number of common parameters that describe the 3D 
data.  This allows anyone to define, generate, and store any number of user, or lab 
defined, data items within the C3D file so that anyone opening a C3D file can access 
them. 

Since the C3D format is not tied to any specific manufacturer it can be freely adapted 
to store the information that the users require. 

The C3D Format 
The C3D format treats information as if it belongs to one of two classes: 

• Physical Measurements. 

• Information about the parameters of the measurements. 

Physical Measurements 
The C3D specification expects physical measurements to be one of two types, either 
positional information (3D coordinates) or numeric data (analog information). 

Each 3D coordinate is stored as a raw X, Y, Z data samples with information about 
the sample - accuracy (the average error or residual), and camera contribution (which 
cameras were used to produce the data). 

Each sample of numeric data can contain analog information from sources such as 
EMG and Force Plates etc.  These numeric samples (typically analog data) are 
linked to the 3D samples so that it is easy to determine the correct numeric data 
values for any 3D sample within the file.  The C3D format can store multiple 
numeric samples per 3D coordinate sample so that analog, and other data sources, 
can be sampled faster than the 3D sample rate.  As a result many C3D files contain 
both analog and 3D data linked frame by frame which is a big improvement over 
formats that store analog and video data separately. 

Storing related information 
in a single file gives a 
greater degree of 
confidence in the data and 
makes it easier to retrieve 
the relevant data. 

Parameter Information 
In addition to physical measurement data, a typical C3D file will also contain 
information about the data such as measurement units and data point labels etc. 
However, unlike most equipment specific formats, the C3D file format can also store 
database information such as the subjects name, diagnosis and other items that may 
be specific to an evaluation protocol or an individual laboratory. All that is required 
to share this data between different labs is that they both agree that the shared data 
should have a particular name. The contents of the data or the nature of the accessing 
system is immaterial once the laboratories agree on the description and name of any 
particular item. 
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Summary 
A C3D file provides a means of storing all the raw data and patient database values 
that would be required by any clinical database. Data stored in the C3D format can 
provide a means of standardizing the interchange of information and can enable 
multi-center studies across a wide variety of hardware and software platforms. 

Welcome to the world of 
easy C3D file access and 
interchangeable data! Your 
C3Deditor makes the file 
format easy to understand 
and use. 

The C3Deditor is a powerful tool that allows you to manipulate the data, and data 
related parameters, in the C3D file with ease.  For instance: 

• The effects of changing the force plate location or applying a different 
scale factor to the analog inputs can be tried out by editing the 
associated C3D parameters. 

• Unwanted data can be deleted from the file or additional analog 
channels or 3D points can be created to store information.  This can be 
very useful if you have written an analysis program that expects a 
certain number of analog channels or 3D points to be present in the file. 

• Analog and 3D data can be filtered and gaps in the 3D data can be 
filled automatically by interpolation to clean up poor quality data.  The 
C3Deditor allows you to define a low pass filter for force data while 
applying a band pass filter to EMG data on a channel by channel basis. 

• You can rapidly assess the quality of the data in any C3D file by 
plotting it.  The C3Deditor contains two powerful tools for this – 3D 
points can be instantly highlighted in red if the residuals are too high, 
while it’s easy to display every sample of any analog channel to see the 
fully bandwidth of the analog data. 

• Almost every command in the C3Deditor can by run automatically 
from a batch file whenever a C3D file is opened.  Complex operations 
to create Parameters and Data can be repeated reliably on any number 
of files. 

• The C3Deditor reads and writes every C3D file format automatically 
and can convert data from one format to another in seconds.  You never 
have to worry about the format of and C3D file that you open because 
the C3Deditor translates them for you.  Files are automatically saved in 
their native format but other C3D formats can be specified. 

• The C3Deditor makes it easy to create C3D files from almost any data 
source by providing the ability to import 3D point values and analog 
values from a Microsoft Excel spreadsheet.  This means that you can 
create C3D files from almost any data source – including any hardware 
systems that do not generate C3D files themselves. 

The C3Deditor is a fully supported program written by a company that fully 
understands the C3D file format and has made a commitment to support it.  Any 
registered user can obtain support on a daily basis from Motion Lab Systems or 
submit C3D file for analysis by our experts.  Most questions are answered with 24 
hours. 

The C3Deditor is available for evaluation in a limited edition that becomes fully 
functional upon registration.  Updates to the program can be downloaded from our 
web site at any time. 
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Registration 
We start by assuming that you managed to install the C3Deditor on your computer.  
Look for the C3Deditor icon on your desktop and double-click on it to start the 
C3Deditor program.  If you can not find the icon then look for a Program Group 
called Gait Lab and an entry titled MLS – C3D Editor.  These are the standard 
locations that will be configured when you perform a normal C3Deditor installation 
which will install the application and its related demonstration files in the 

 directory tree. C:\Program Files\MLS\C3Deditor\…

If you have any problems at this point you can try removing the C3Deditor and 
reinstalling it – the C3Deditor uninstall program is called REMOVE.EXE and can be 
found in the same directory as the C3Deditor.  It will uninstall the C3Deditor 
application and remove all the C3Deditor specific registry entries.  If you remove a 
registered copy of the C3Deditor then you will have to enter the registration 
information again when you reinstall the program. 

If you entered the registration information correctly during installation the C3Deditor 
will display your name and location when it is started.  If you made a mistake or did 
not register the program then the opening screen will display a notice that the 
program is an unregistered copy of the program. 

If you believe that you entered the correct registration details during installation then 
you can register the program now by selecting the Registration option from the Help 
menu and correcting any errors in the information that you entered.  The Registration 
information must be entered exactly as shown on your software license. 

Please contact Motion Lab 
Systems if you have any 
problems registering or 
installing the C3Deditor. 

An unregistered copy will not allow you to view all analog channels or edit large 
files and will keep reminding your that it’s unregistered.  You will only be able to 
view data in the first eight analog channels and will not be able to save any files that 
contains more than 100 frames of 3D points or markers or view more than the first 8 
channels of 3D or analog data.  Registered software has none of these little 
annoyances. 

 
Figure 6 - Registering the C3Deditor 
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If you have not purchased a copy of the C3Deditor then just enter your name and 
location or organization information and enter the evaluation registration number of 
0000-0000-0000-0000 – the application will then run in an evaluation mode. Once 
you have registered the C3Deditor you will see your name and location information 
displayed on the background whenever there are no files open. 

Opening a C3D file 
You are now ready to start using the C3Deditor…  

 
Figure 7 - Opening a C3D file in the C3Deditor 

If you selected the default installation options when the C3Deditor was installed you 
will have some sample data copied into a subdirectory and the information about 
these files will be entered as the most recently used files.  You can open these files 
quickly from the File menu by selecting them with the mouse.  The first file in the 
list should be a file called demo4.c3d – use your mouse to select this file and click on 
it to load the file into the C3Deditor. 

Once you have opened You can open several C3D 
files at the same time in the 
C3Deditor and copy 
parameters and data 
between them. 

demo4.c3d the C3Deditor will display the contents of the 
C3D file header in the lower left window area and the structure of the file and 
information about some events in the upper two windows.  The Graphical window 
on the right side will be blank, as you have not selected any information to display. 
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Figure 8 - The Tree, Events and Data window display information about the file. 

From a quick glance at this initial view of the C3D file that we have just opened we 
can immediately determine quite a bit of information about the contents of the file.  
The top two windows show that: 

• The file contains four parameter groups with POINT, ANALOG, 
FORCE_PLATFORM and SUBJECT information.  Parameter Group 
names are always displayed in CAPITAL LETTERS to distinguish 
them from Analog data, 3D data and header information items within 
the  display. Tree

• The Events window to the right of the Tree window shows that there 
are four events recorded in the file.  The labels of three of the events 
(HS, TO and IC) suggest that the file contains at least one gait cycle – 
Heel Strike, Toe Off and Initial Contact. 

When a C3D file is first opened, the Data window below the Tree window will 
always display the contents of the C3D file header, together with some other useful 
information that can be deduced from reading the file header.  This information can 
be viewed at any time by clicking on the Header Information tree item in the Tree 
window and provides a quick method of determining some general information about 
the C3D file that is currently displayed.  Note that many of the items displayed are 
identical to parameter values within the C3D file and will be updated automatically. 
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The C3D File header can tell us quite a lot about the data within the file: 

• The file contains both analog and 3D data (Analog Channels and 3D 
Points are both non-zero). 

• The data is stored in an Intel PC format (File Format) 

• The data is stored as integer values (Data Type). 

• Last Frame – the file contains 193 frames of data for 12 targets (3D 
Points). 

• Analog Channels – the file contains 16 analog data channels. 

• Sampling Rate – the 3D data has a 50 Hz. frame rate 

• There are two analog samples (A to V Ratio) for every 3D frame – so 
the effective analog sample rate is 100 Hz – two analog samples per 
50Hz 3D point sample. 

In addition the Nyquist Frequency of the analog data contained within the C3D file is 
calculated and displayed.  This is always half the analog sampling frequency and 
indicated the highest spectral content within the C3D file. 

Note that the C3Deditor opened the file automatically after determining the correct 
file format.  If we were trying to analyze this data using a software package that 
was unable to read an Intel file format then we could simply select the Save As 
option form the File menu and convert this file to another C3D format that the 
program could read.  Try this – save the file as a DEC integer file using a different 
file name… 

The C3Deditor reads and 
saves data in any C3D 
format as well as translating 
any C3D file into any one of 
three ASCII formats. 

In addition to being able to read and write C3D files in any standard format (DEC, 
SUN, INTEL with INT or Floating Point data) the C3Deditor can also convert any 
C3D file to any of three ASCII text file formats that are easily read by almost any 
other program.  For ease of use, and to keep the file sizes reasonable, the data is 
saved in separate files so that you can easily create a file that contains only analog 
data, 3D data or just the parameter information.  These are accessed via the three text 
save commands – Save Analog Data, Save 3D Marker Data, and Save Parameter 
Data. 

Finally – you can stop editing a C3D file by selecting Close from the File menu or 
clicking on the Window close button in the top right corner of the File Window.  
Exiting the C3Deditor also closes the file – you’ll be prompted to save it if you’ve 
changed anything in the file. 

If you make any changes to 
a C3D file then the 
C3Deditor will always 
prompt you to save the file 
before you exit. 

You should now know how to open a C3D file in the C3Deditor and discover some 
basic information about the contents and format of the file.  You can convert the data 
in the file to another C3D file format or save it as ASCII text. 

It’s worth noting that that many other programs are not as flexible as the C3Deditor 
and assume that the C3D data is presented to them in a specific C3D format (for 
example DEC Integer).  Don’t change the C3D file format of important files without 
checking that your other applications can read the files. 

When a file is opened, the application looks to see if the format of the C3D file is 
correct.  If there is any problem, it gives you a description of the problem if you have 
a registered version of the application.  An evaluation version will only tell you that 
it detected a file format problem. 
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Viewing the C3D file structure 
The multitude of information in the C3D file structure can appear to be very complex 
when you first start to use these files.  Many first-time users find this intimidating 
and start to treat C3D files as a black box that, once they have managed to extract 
their data, they never use again. 

The programmers at Motion Lab Systems have been using and creating C3D files for 
over ten years.  We have written the C3Deditor to make C3D files easy to use and 
navigate while allowing the average user complete control and access to their data 
and information contained in the C3D file. 

So let’s see what’s in the file…  We’ve already determined some basic, but very 
important, information about the overall contents and type of file and you may 
have noticed that, once we’d determined the format of the file, we talked about 
either data (3D and/or analog data) and parameters (POINT, SUBJECT etc).  Let’s 
start with the data… 

Most common C3D files will 
contain both Data and 
Parameters. 

Don’t worry if you don’t 
know what Groups and 
Parameters are at this point 
– we’re going to explain 
them when we get to the 
section “Viewing the 
Parameters” 

We’ll start by looking at the data in the demo4.c3d file that we just opened.  The 
Tree window in the top left corner of the screen shows the structure of the C3D 
file.  The first three entries in this window are always Header, Analog and 3D Data 
which are always present.  The various groups of parameters follow these three 
items – we’ll get to them later… 

Viewing Analog Data 
You can select a view of the analog data by first double-clicking the mouse on the 
Analog item in the Tree window.  This will select the Analog data and expand the 
tree to display all the analog data items that are stored in the file.  There can be quite 
a few so you’ll usually see a scroll bar on the right side at this point. 

Analog data consists of a number of channels that contain samples of analog 
information.  The C3Deditor will display these channels in numerical order (starting 
at channel 1) together with a “Label” that is intended to describe the analog channel. 

In the case of the demo4.c3d file we can guess from the labels used (FX1, FY1, FZ1, 
MX1 etc) that the analog information is from two force plates since we seem to have 
two sets of labels, each consisting of three forces (FX, Fy, and FZ) and three 
moments (MX, MY, and MZ).   Force plate #1 occupies channels 1 through 6 while 
force plate #2 occupies channels 9 through 14.  Channels 7-8 and channels 15-16 
may be unused since there is no specific label attached to them other than a channel 
number, which may simply be the default for this particular file. 

You may remember that there was a parameter group in the Tree window called 
FORCE_PLATFORM.  So it’s a safe assumption that we can find more information 
about the exact configuration of the force plates by looking at the parameters in that 
group since the published C3D Format specifies that positional and calibration 
information about Force Plates is stored in this parameter group.  We’ll do that later 
but first let’s take a graphical look at the data… 

 

First let’s check that your copy of the C3Deditor is setup more or less the same 
way as the one that I used to generate the illustration – this is important because 
otherwise you’ll see a different graphical view of the data.   Now select analog 
channel 3, which contains the FZ1 data (vertical force from the first force plate).  
You should see an illustration that looks a lot like the one below. 

Check that the Edit, Frames 
and Scale buttons are all up 
(that is they do not show up 
shaded which would 
indicate that they’re down – 
play with them if you’re not 
certain). 
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Figure 9 - The C3Deditor provides many different ways of viewing the data. 

Depending on your screen resolution you may see quite a bit more of the data 
editing window (lower left) and the graphic window (on the right side).  You can 
change the appearance of the graphic plots by selecting different plotting options.  
You can select the graphic view on the right side and display the Tools menu by 
clicking anywhere in the graphic area with the right mouse button.  This will 
display the Tools menu – select options at the bottom of the menu to display the 
options setting for the C3Deditor. 

Context sensitive help is 
available by pressing the F1 
key while examining the 
options.  Select any item and 
press F1 for detailed 
information about the 
feature. 

There are three pages of options – we are interested in the middle page which 
controls the Views options.  At this point the Options for the General page and the 
Interpolation page are not relevant to the discussion – we’ll get to these later on. 
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Figure 10 - The graphs are controlled by the Views page in Options. 

Select the Views options by clicking on the Views tab, which shows the following 
choices: 

• Scale Analog Data – checking this option will display all analog data 
as scaled the individual analog scale parameters associated with each 
channel .  If the option is not checked then data will be shown as analog 
sample values. 

• Scale 3D Data – this option will display all 3D data as scaled in lab co-
ordinate units (usually millimeters).  If the option is not checked then 
data will be shown using the integer storage format. 

• Show Analog Sub Frames – when analog data contains more than one 
sample per video frame this option will display every analog sample.  
This will greatly increase the horizontal length of the analog graph but 
will eliminate the filtering effect that is seen when only displaying a 
single analog sample per video frame. 

• Show data in list – normally this is checked to display the data as 
numeric values in the data display window in the lower leftof the 
screen.  It is occasionally desirable to turn this display off when editing 
very large files on slow machines – disabling the data display can speed 
up the screen data refresh rate. 

• Flag data residuals above this value as high – 3D data with residual 
values that are greater than this will be plotted in the selected color. 

• Vertical Analog Data Scale – this is the vertical size of the analog 
graph in inches.  Analog data is displayed one channel at a time. 

• Vertical 3D Data Scale – this is the vertical size of a single 3D data 
graph in inches.  As there are three components to 3D data (X, Y, Z) 
there are three graphs plotted. 
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• Distance between frames – Analog Data – this sets the horizontal 
scale of the analog data. 

• Distance between frames – 3D Data – this sets the horizontal scale of 
the 3D data. 

• Choose Distance between Frames to fit screen – this option overrides 
all display options except the “sub-frames” option and forces the 
graphical data to fit within the screen boundaries. 

You can use these options to independently adjust the scaling of the Analog and 
3D data to fit the screen.  If your current view of the analog data does not show the 
entire data channel then adjust these values to produce the graph size that you like 
and show the whole of the analog graph. 

The buttons in the top right 
of the View option tab allow 
the user to select specific 
colors to draw the 3D point 
data lines based on the 
residual value of each data 
point. 

Note the range of data that is displayed – 2078 through to a peak of 3018.  These 
are integer sample values, exactly as recorded by the analog data collection system.  
Now click on the Scale button in the toolbar to apply the analog scale parameters 
that are associated with this channel of data… 

 The Scale button 
affects the display of analog 
and 3D data 

The first thing that you’ll notice is that the graph flips upside down – this is  a result 
of the analog scaling value for this channel being negative which is normal for force 
data.  Closer examination of the graph will show that the values of the data range 
have also changed.  The data now appears to have a range of -22.32 through to a 
value of  -721.68 and these numbers are also reported in the same format in the data 
window in the lower left side of the C3Deditor.  Click on the scale button a couple of 
times and watch the values change as the scaling factors are applied and removed 
from the analog data.  

 
Figure 11 - Force data can be viewed with the scaling factors applied. 
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The dotted vertical lines on the graph correspond with the times shown in the 
Events box next to the tree window.  These will only appear if events have been 
defined in the C3D file header and the status of these events is ON.  The events can 
be edited by double-clicking on the desired event in the Events box which will 
bring up the Events edit window if the C3Deditor is in Edit mode. 

The C3Deditor must be in 
Edit mode before any data 
can be manually altered – 
this includes the event 
status. 

Now let’s have a look at some 3D marker data… 

 
Figure 12 – Displaying the 3D Tree of Marker Names 

Viewing 3D Data 
First we roll up the analog display tree by double clicking on the Analog Data header 
in the Tree window (top left side of the C3Deditor).  Now double click on the 3D 
Data header to expand the tree and display the contents of the 3D data values.  These 
expand down in the same way as the analog channels and list the available marker 
trajectories in the file.  Each trajectory will normally have an associated parameter 
label, which will be displayed with the marker number.  These labels are stored as 
parameters and usually follow a labeling convention set up when the data was 
recorded. 

In this case we can see that there is data from twelve markers and we can guess that 
this is bilateral data from a subject with six markers on each side of the body. 

You can use the up and down arrows to move through the tree.  Whenever an Analog 
Data or 3D Data entry is highlighted the contents of the item will be displayed in the 
graphical window to the right.  Use the arrow keys to select the first marker ( 

When a group name is 
highlighted (such as Analog 
Data, Point, Analog etc.) the 
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right arrow will display the 
sub-items in the tree and the 
left arrow will close an 
expanded tree.  

1<RASI> ) in the 3D Data.  This should produce a display similar to this: 

 
Figure 13 - 3D points can be viewed as X,Y,Z values and graphed at the same time. 

You may have to adjust the graphical window options slightly in order to be able to 
view all the graphs.  The graphical window will display three graphs in order of X 
co-ordinate, Y co-ordinate, and Z co-ordinate.  Note that this display is unscaled, 
that is to say that the values shown for the co-ordinates are the integer values stored 
in the file.  Click on the Scale button in the toolbar to change this to display the 
actual 3D data values.  The Scale button action for Analog and 3D data is 
independent – setting Scale ON for 3D data does not set it ON for Analog data. 

 Use the Scale 
button on the toolbar to 
switch the display of data 
values between integer and 
real-world values 
(millimeters). 

The events in the C3D file header show up as dotted vertical lines in the color of 
your choice.  They appear at exactly the same time positions in the graphs of both the 
analog and 3D data. You can choose the color from the Tools menu by right-clicking 
in the graph area and choosing options.  Select the Views tab and click on the button 
marked Event Line Color. 

The graphed marker trajectories will be in black – possibly with some parts of the 
graphs showing in some other color (red) as in the illustration.  These sections of 
the graph indicate the parts of the marker trajectories that have residual values that 
are greater than a set value.  You can set the residual value from the Tools menu by 
right-clicking in the graph area and choosing options.  Select the Views tab and 
modify the value in the box marked Flag data residuals above this value as high.  
Any trajectory point that has a residual that is greater than this value will be 
highlighted.  You can also choose the color from this dialog. 

You can rapidly assess the 
quality of 3D data in the 
C3D file by highlighting 
every part of the trajectory 
with both high residual 
values or 0.0.  High 
residuals may indicate 
inaccurate 3D coordinates 
while 0.0 residuals indicate 
filtered data points. 
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Figure 14 - Set the residual highlight value in the Views page in Options. 

The residual values associated with each 3D point can be seen in the Data window in 
the lower left corner of the C3Deditor window.  

 
Figure 15 - The data window displays all the information about 3D points. 

This window displays the frame numbers and coordinate values of each 3D sample 
together with each associated residual value and camera contribution mask.  In the 
example shown above the data is scaled.  Note that the residual value is always a 
scaled value even when the 3D data is displayed as unscaled INTEGER values.  

Viewing the Parameters 
Now that we’ve had a look at the data let’s examine some of the information that’s 
stored in the C3D file about the data.  The ability to store both data and information 
about the data in an extendable and easily accessible manner is one of the principal 
features of the C3D file format. 

We start off by returning to the Tree window in the upper right corner of the 
C3Deditor window – all navigation in a C3D file starts at this point since this 

If you already know how the 
groups and parameters are 
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structured and are just 
reading this tutorial to 
understand the C3Deditor 
then you can skip ahead. 

window shows the complete structure of the file and allows you to select any item 
for examination or editing.  It helps, at this point, to know a little about the 
structure of the parameters in a C3D file… 

The basic concept is that all of the information about the 3D and Analog Data can be 
grouped according to its association with the data.  Therefore all Parameters in a 
C3D file are stored in Groups – you’ll see these two words very often as you read 
through the tutorial and manual so it’s a good idea to get a firm grasp of their 
meaning.  A Group is simply a collection of related Parameters that all have some 
loose association with each other.  As you move through the parameters you’ll see 
that the POINT group contains parameters that deal with either the 3D Data or the 
display of the data.  The ANALOG group contains parameters that define and 
control the analog information while parameters that relate specifically to any force 
plates are stored in the FORCE_PLATFORM group. 

In general you will find that almost all C3D files will contain at least a minimum of 
two groups – these are the POINT and ANALOG groups.  Most C3D files will 
contain other groups such as FORCE_PLATFORM and SEG as well.  However, 
it’s important to note that the groups will not always contain the same parameters.  
The C3D file specification defines the way that data and parameters are stored.  
The specification does not require that specific parameters of groups exist in a file, 
although the majority of the parameters in the normal POINT, ANALOG and 
FORCE_PLATFORM groups have well defined functions and contain well-
documented values. 

The standard C3D 
parameters were first 
defined for use with AMASS 
– the Adtech Motion 
Analysis Software System.  
This remains the standard 
for parameter definition 
although many hardware 
manufacturers are adding 
additional parameters and 
groups to those defined in 
the AMASS User’s Manual. 

Now that you have a little background information about the C3D parameters we can 
return to looking at the Tree window which has the 3D Data section expanded at the 
end of the previous section. 

Double-click on the 3D Data item in the Tree to close this section and then double-
click on the POINT parameter group to expand this and see what parameters are in 
the POINT group. 
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Figure 16 The tree windows displays the Point parameter group in the demo4.c3d file. 

Note that if you open other C3D files then you may see different parameter groups 
and values in them - this is quite normal.  While most C3D files will have a POINT 
and ANALOG group it is not required that every file contain identical parameters.  
The sample C3D files that are supplied with the C3Deditor have different parameters 
and groups.  After you have been through this tutorial you may want to use the 
C3Deditor to view these differences between the supplied demonstration files. 

Let’s start off by examining the parameter RATE – move the cursor to the 
parameter RATE in the group POINT (we will describe this as POINT: RATE in 
this manual) and click on the item.  It will be highlighted and the data window will 
be updated with the contents of the RATE parameter. 

Remember that you can use 
the keyboard arrow keys to 
more around the Tree 
window. 

 
Figure 17 - C3D Parameter information. 

The data window displays everything that there is to know about the parameter that 
you have selected.  In addition, every item in this parameter can be changed (we’re 
going to get to the actual editing in a bit). 

For the parameter that we’ve selected (POINT: RATE) this window tells us that it’s 
name is RATE and that it’s number is 1 – the number is an internal value that 
identifies the group that owns the parameter.  This parameter has a description string 
that tells us what the parameter controls - * Video data frame rate – not all 
parameters have this description (often it’s left blank) but it’s very useful because it 
can be used to provide information about the function of the parameter.  If you create 
any parameters with the C3Deditor you’ll find that it’s a good idea to always add a 
description to the parameter. 

The POINT: RATE parameter is shown as locked (i.e. TRUE)– this indicates that 
normal programs that access the C3D file should not attempt to change the value of 
the parameter.  Although the C3D editor allows you to change the locked state and 
edit the value of locked parameters it’s not a good idea to so without a thorough 
understanding of the consequences. 

The data type is FLOAT – this parameter has a floating-point value which means 
that it can contain data with fractional information (as opposed to INTEGER or 
BYTE values that can only hold whole numbers).  The C3Deditor allows you to 
switch between numeric data types (BYTE, INTEGER and FLOAT) but not 
between the CHAR type and a numeric type. When you switch between the 
numeric types, the parameter data will be converted to the new type.  This will 
cause the data value to be rounded to the nearest whole number when you convert 
float data to integer or byte and back again. 

It’s usually not a good idea 
to change the data type 
unless you are trying to 
correct an error in the file 
format where a parameter 
has been created with the 
wrong data type. 
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And finally – the parameter has 0 dimensions.  It’s a single value in other words and 
not an array.  The value of the parameter is shown as the Data<0> value and is 
50.000  - in other words – this file contains Video data that has a frame rate of 50 Hz. 

OK – that was easy – now lets look at a parameter that contains an array of values.  
The POINT: LABELS parameter contains the ASCII labels that are used to identify 
the 3D data – these are often called marker labels.  Use the mouse or the keyboard 
arrow keys to highlight the LABELS entry and you’ll see an example of a parameter 
that has an array of data associated with it. 

Notice that there is now a scroll bar on the right side of the Data window that can be 
used to scroll through the data since this parameters contains 12 separate data values 
and more than fills the window.  You can use the mouse to scroll through the data or 
use the keyboard arrow keys. 

 
Figure 18 - Displaying the parameter values. 

This parameter has the same number as the previous one that we looked at – 
indicating that it’s a member of the same group.  Unlike the POINT: RATE 
parameter this one is unlocked.  It’s usually OK to modify an unlocked parameter if 
you need to do so. 

Since the POINT: LABELS parameter is used to record the ASCII labels that are 
used to quickly identify the data this parameter has a CHAR data type – it’s used to 
store characters. 

The big difference between the POINT: LABELS parameter and the POINT: 
RATE parameter is that this one contains an array of data.  The dimensions line 
tells us how many dimensions are in the array – this is followed by a description of 
the dimensions themselves.  This is a 4 by 12 array – it contains twelve data entries 
(the labels themselves).  Each label is four characters in size. 

It’s worth mentioning that 
the first programs that 
created C3D files were 
written in FORTRAN and 
this heritage is visible at 
some levels of the C3D file 
structure. 
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 Editing the C3D File 
So far all we’ve done is to look at the data and parameters without trying to change 
anything.  In fact, if you have tried to edit any of the data you’ll have found that you 
can’t edit anything.  This is because (if you followed the instructions at the start of 
the tutorial) the data and parameter edit functions have been turned off.  If you just 
want to browse through the data then this is the safest way to use the C3Deditor. 

Look at the toolbar and click on the Edit button to enable editing.  When this 
button is down, you can double-click on any of the data items in the Data window 
to open the editing dialogs and change any part of the data or any parameter.  The 
ability to change data or parameters is disabled when the Edit button is up.  In 
addition the various menu items that involve editing or changing the data are also 
disabled. 

 Click on the Edit 
button in the toolbar to 
toggle the editing of 3D 
data, Analog Data and 
Parameters. 

Editing Parameters 
Now that the C3Deditor is in Edit Mode we can try changing some of the data.  
Since we’ve been looking at the POINT: LABEL parameters let’s start with those 
first.  Double-click anywhere in the Data window to open the parameter editing 
dialog – you’ll see the following dialog appear that enables you to change almost any 
part of the POINT: LABELS parameter.  Move your mouse over the various items to 
get a quick description of the function of each part of the parameter editor dialog. 

 
Figure 19 - The parameter editor display allows any aspect of the parameter to be changed. 

The Parameter Editor dialog allows you to edit the contents of any parameter and 
change any property of the parameter.  In the example above the parameter name is 
LABELS – it has a description that is Point Labels.  Both of these may be changed 
if you wish by simply clicking on the item and editing it using the keyboard arrow 
keys and normal editing keys (Insert, Delete, End etc.) 

Please be cautious when 
you edit C3D file 
parameters – changing 
some characteristics of a 
parameter may cause 
programs that access the 
C3D file to fail. 

This parameter is not locked which means that other programs may change the 
parameter data.  Setting this item by clicking in the associated box will mark the 
parameter as Locked.  Since the C3Deditor is designed to allow access to any part of 
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the C3D file structure the setting of this parameter characteristic has no effect on the 
ability of the C3Deditor to change parameters. 

Locked parameters cannot be edited unless the application finds a sub-key Locked 
with a value True in the HKEY_LOCAL_MACHINE\Software\MLS\C3Deditor key 
in the registry.  This key has to be added manually if you want to edit the locked 
parameters.  Your ability to edit locked parameters can be seen in the About box of 
the application. 

Locked Parameters should 
never be changed without 
careful consideration of the 
consequences of the change.  
It is recommended that you 
make a backup of any C3D 
file before changing any 
locjked parameter value. 

The Group to which the parameter belongs is controlled by the parameter number 
(do you remember seeing that earlier?) – the group box allows you to move this 
parameter to another group if you wish.  All you have to do is select one of the other 
groups already present in the C3D file from the list that’s presented in the Group 
box.  You cannot create a new group from this dialog in the C3Deditor – if you want 
to create a new group then use the Edit menu and select the New option which will 
be the next topic after we’ve finished describing the rest of the Parameter Editor. 

The Data Type can be changed to any of the items in the Data Type list.  Since this is 
a CHAR variable there really aren’t any other choices but if you were editing a 
parameter with a numeric Data Type then you would be able to change the Data 
Type to INTEGER, FLOAT or BYTE. 

The LABELS parameter has two dimensions, which are shown in the Dimension 
List.  The first dimension is the length of each label, while the second dimension is 
the number of labels in the parameter.  If you wanted to add additional labels to 
this parameter then you would need to change the second value – changing the first 
value will alter the size of each label. 

Many parameters are 
interlinked so if you change 
the number of data values in 
LABELS then you will need 
to add additional 
DESCRIPTIONS too. 

And finally – the parameter data.  This is probably the item that you are most likely 
to want to edit.  Simply double click on any data item and use the normal editing 
keys to change the parameter to a new value.  Remember that in this case the labels 
cannot be more than 4 characters long – if you create any labels that are longer than 
4 characters then they will be truncated as soon as you finish editing them.  If you 
want to use longer LABELS then you will need to increase the size of the first 
dimension in the dimension list. 

Creating New Groups and Parameters 
All parameters in the C3Deditor can be changed in the same way using the same 
Parameter Editor dialog that we’ve just used but this does not allow you to create 
new groups or parameters. 

The creation of new Groups and Parameters is a very simple process, made easy by 
the C3Deditors’ use of the Windows point and click interface.  If you want to create 
new parameters then all you will need to do is open the Edit menu from the menu bar 
at the top of the C3Deditor, select the New option and chose the item that you want 
to create from the menu. 

You can create both groups and parameters from this menu so lets start by creating 
a new Group.  Select Group from the Edit - New menu option and you’ll be 
presented with a dialog box that will ask for a Name and Description.  The group 
name is required; all the other boxes are optional except the Number box, which 
will already be filled in with a suitable group number (it’s a good idea not to 
change it). 

Although it’s not required 
that Groups have 
Descriptions you will find 
that it’s really useful to fill 
this field in so that you will 
know the general purpose or 
function of the Group. 
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Figure 20 - New C3D groups can be created with any name or number. 

You can create locked groups by checking the Locked box but this is not commonly 
done – usually parameters are locked on an individual basis so it would be normal to 
leave the Locked Box unchecked. 

The ability to edit locked 
parameters is disabled by 
default.  

Let’s create a group – the general convention is that Group and Parameter names are 
in UPPER CASE letters so let’s create a group called INFO by typing in “INFO” to 
the Name box and “Test group” to the Description.  Click on OK when you’re done 
and you’ll see that the group has been added to the Tree window.  Click on the INFO 
group and you’ll see that the Data window displays the same information that we just 
entered. 

 
Figure 21 - The C3Deditor can display the group information. 

If any of this information is wrong then you can double-click on the Data window to 
bring up the same dialog that we used to create the group and correct any errors. 
Now that we’ve created a new group the next step is to create some parameters for 
this group.  This is done in the same way as creating the group except that we have to 
provide quite a bit more information to create a parameter.  Although the C3Deditor 
makes it very easy to create parameters it’s still a good idea to have a written 
description of the parameters that you are going to create before you start editing a 
C3D file.  So let’s define three parameters that we’re going to add to the INFO 
group: 

• INFO: FULL_NAME – a string of 64 characters that can be used to 
store a persons name. 

• INFO: DATE – a string in the form MMM-DD-YYYY that will hold a 
date.  For clarity we’ll use a three-letter abbreviation for the month, two 
numbers for the day and the full century for the year. 

• INFO:  HEIGHT – a value that will record the person’s height.  This 
will be a FLOATING POINT value so that we can use Floating Point 
numbers.  There’s no assumption about the units that the height will be 
measured in but it would be sensible to assume that it will be entered in 
the same units as the data.  These are recorded in the POINT: UNITS 
parameter. 

Let’s get started - open the Edit menu from the menu bar at the top of the C3Deditor, 
select the New option and choose Parameter the menu.  The first question is going to 
be – is this a character string or a numeric parameter? 
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Figure 22 - Parameters can be created as Char (text) or Numeric values 

This is important because, although it’s possible to change between numeric data 
types (INTEGER, FLOAT and BYTE), it’s not possible to change from CHAR to 
numeric data and back again. 

We’ll create them in the same order that we defined them so the first parameter 
will be CHAR so select OK and enter the Parameter Editor.  Fill in the Name as 
FULL_NAME and add a Description such as “Full name of subject”.  There’s no 
requirement to make this a Locked parameter so we can leave the Locked box 
unchecked. 

For compatibility with older 
programs it’s a good idea to 
always use upper case 
letters for the names of 
groups and parameters. 

Now go to the Group selection box and pick the group that is to contain this 
parameter from the list of existing groups that will be displayed.  The parameter 
editor defaults to displaying the first group so you’ll need to specifically select the 
INFO group from the list. 

The size of the parameter is set in the Dimensions List – this needs to be changed to 
the correct size for this parameter, which is 64.  Since it’s a single string of 
characters there will only be a single dimension. 

Since the Data Type is CHAR there’s nothing to change here so we can add the 
subjects name by just double-clicking in the parameter data window on the right side 
of the dialog box and entering the value for the FULL_NAME parameter.  We’ll just 
pick something at random – Janet N. Brad.  At this point your Parameter Editor 
should look like this: 

 
Figure 23 - The parameter editor allows complete control over any parameter type. 
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Click OK to create the new parameter and it’s done.  You can select the new 
parameter from the Tree window and check that it contains the right values – if 
anything is wrong you can simply double-click on the window to return to the 
Parameter Editor and make the necessary changes and corrections.  Then click OK to 
save them and you’re done – you should be able to see the parameter defined exactly 
as shown in the Data window here: 

 

Figure 24 - Information about any selected parameter is displayed in the data window. 

Now create the other two parameters that we defined earlier.  The DATE parameter 
is fairly simple although you’ll discover that we did not define one important piece 
of information when we wrote down its details earlier – you’ll have to figure that out 
while you’re creating the parameter. 

Remember that if you make mistakes you can double-click on the parameter to 
correct the error.  Look in the first group in the Tree window if you create a 
parameter and can not find it in the appropriate group.  Parameters will be created 
in the first group by default and your parameter may be there if you forgot to select 
the correct group for the new parameter.  If this happens then just double-click on 
the parameter and change the assigned group to the correct group. 

The easy to use, intuitive 
design of the C3Deditor is 
the result of many years 
experience with C3D files 
and makes any editing task 
simple to accomplish. 

 
Figure 25 - the new INFO group displayed in the Tree Window. 

A view of the Tree window with the INFO group expanded should look like the 
illustration shown above.  The INFO group has been expanded to display the three 
parameters that you’ve added. 

Note that all the names of the groups and parameters are in upper case – this is not 
required by the C3D specification but some older programs will expect that these 
names are in upper case so it’s a good idea to stay with the convention for 
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compatibility.  If you write any programs that access C3D parameters then you 
should not assume that parameter and group names are always upper case. 

The Data window displays for the two parameters that you’ve added should look like 
these two illustrations below: 

 
Figure 26 - The data window provides verification of any new parameter values. 

The one item that we had not defined earlier was the dimension of the DATE 
parameter – since this is a string of characters separated by dashes we need to allow 
for eleven characters (3 + 1 + 2 + 1 + 4).  Since we did not know what the date 
would be I just entered a blank date to check the parameter size. 

 
Figure 27 - The data window displaying the HEIGHT parameter information. 

Deleting Groups and Parameters 
The only other thing to cover is deleting groups and parameters.  This is very easy 
as all you have to do is highlight either the parameter or the group in the Tree 
window and then go to the Edit menu at the top of the C3Deditor and select 
Delete.  You can delete parameters individually or simply delete the group.  
Deleting the group will also delete all the parameters associated with the group – 
you’ll be asked to confirm the operation so it’s difficult to make a mistake. 

 When any Group or 
Parameter is deleted the 
Undo button on the toolbar 
will become active and can 
be used to restore the last 
item that you deleted. 

If you delete a parameter or group in error you can use the Undo button on the 
toolbar to undo the results of the last operation. 

Remember to be cautious when deleting parameters and groups in any C3D file as 
they will often contain information about the 3D point and analog data that describes 
the information stored in the C3D file.  Do not delete any parameters or groups 
unless you are absolutely certain that they are not required. 

The C3Deditor User Guide Tutorial  •  31 



 

Editing 3D and Analog Data 
The C3Deditor allows you to create, delete or edit the 3D and Analog data in any 
C3D file.  We’ll start off by editing the 3D data so (using the demo4.c3d example 
file) select the 3D Data from the tree windows and double-click on it to expand the 
list of 3D trajectories.  We’ll start with RASI (Right Side ASIS marker) so click on 
the RASI label and you’ll see that the graphical; window on the right side is now 
displaying the X, Y, and Z co-ordinate values and the Data window is displaying the 
numerical values. 

You can use the scroll bars to browse through the Data window as there’s nearly 200 
frames of data in the file.  The individual titles to the Data window can be moved 
from side to side so that you can see all of the data or you can use the horizontal 
scroll bar.  Note that in the following illustration the Edit and Scale buttons are both 
down (selected) and that the Frames button is not selected. 

 
Figure 28 - The C3Deditor provides many convenient ways to edit the data. 

To change any data values in the Data Window simply double-click on the number 
that you want to change and enter a new value.  The new data value will be 
displayed in both the Data window and the Graphical Window on the right.  Any 
values that you enter will be checked to make sure that they fall within legal ranges 
for the C3D file. 

You can use the standard 
Windows keyboard 
shortcuts to Copy and Paste 
samples of data between 
frames – use Ctl-C to copy 
and Ctl-V to paste. 

 
Figure 29 – 3D point data can be changed directly in the Data window. 
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You may also edit the residual value and the camera mask – setting the residual to a 
value of –1 will mark the point as invalid and a gap will appear in the graphical 
display at that frame.  If you enter data to estimate the position of a point that is 
initially shown with a residual of –1 then you must reset the residual value to 0.0 
before the new data will be used in the graphical display or by other programs that 
access the new C3D file. 

When editing Analog data you will find that there can be multiple samples per 
frame.  These additional samples of data are shown in the Data window and can be 
edited in the same way as the 3D data.  The graphical display of analog data that 
has more than one sample per frame is affected by the Frames button, which 
controls the display of the additional samples.  When this button is UP the 
graphical display will only show the first sample of each frame of data. 

Analog data is edited in 
exactly the same way as 3D 
data except that it does not 
contain any residual or 
mask information.   

 
Figure 30 - Analog values can be edited in the Data window 

The vertical scale of the graphical display of analog data is automatically calculated 
to display the entire range of data.  This is normally the best view so that you can see 
the quality of the signal, for example making it easy to assess the amount of noise on 
the baseline of Force Plate signals.  If you want to see the analog signal scaled so 
that the full range available to the recorded signal is shown then you can simply edit 
the first two samples of analog data to 0 and 4096 – the maximum and minimum 
values of 12-bit integer data.  The display will then show then entire dynamic range 
available to the analog channel. 

Creating New Data 
The C3Deditor can create new data in a C3D file by adding analog channels, 
additional 3D trajectories, or by adding additional frames of data to existing C3D 
files.  Each of these features is available from the New option in the Edit menu at 
the top of the C3Deditor. 

 You must be in 
Edit more to create new 
data in a C3D file. 
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Figure 31 - Use the Edit menu to create new data channels. 

Frames of data can be added at any point in the C3D file.  They can be inserted at 
the beginning of the file, at the end of the file or at any point within the file.  The 
number of analog channels or 3D marker trajectories in the file will not change when 
frames are added to a file. 

The new frames can be preset with a range of values.  The data will be inserted into 
the file so that it appears that the new frames are part of the original file but will 
contain only the data values chosen at the time that the frames are created.  If frames 
are added inserted into existing data then the data values will be interrupted and will 
resume and the end of the new data frames. 

Analog Channels can be inserted into a C3D file.  Analog channels are inserted at 
the location of the analog channel selected in the tree.  If no analog channel has been 
selected, the new channels is appended to the end of any existing analog channels 
and can be created with a preset, static, analog value or can be pre-loaded with either 
a square wave or sine wave.  This feature has been primarily added so that analog 
channels can be “manufactured” to test C3D filtering programs that access the 
analog data channels.  In addition to creating the analog channel the C3Deditor also 
creates the basic ANALOG Parameters that are needed to describe the new channel.  
This feature makes it easy to add any number of analog channels to a C3D file. 
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Figure 32 - The C3Deditor makes it easy to create a new analog channel. 

If you are creating a channel and preloading it with a signal then you will also have 
to specify the signal amplitude (in terms of minimum and maximum signal values) 
and the frequency.  When you specify the signal frequency remember to take the 
analog sampling rate into account – you cannot create an analog signal that changes 
faster than the signal can be sampled. 

 
Figure 33 - New analog channels can be pre-loaded with calibration data. 

The Undo button can reverse any analog channel creation operation if it is used 
immediately after the channel has been created.  

3D Marker channels can be inserted into a C3D file at the marker that has been 
selected in the tree.  If no marker has been selected, it is inserted at the end of an 
existing list of markers.  New 3D marker channels can be preloaded with a set of co-
ordinate values to simulate a single point that is fixed in the 3D co-ordinate space.  
These values can be entered as scaled or un-scaled values. 

Deleting Data 
While the C3Deditor makes it easy to delete a 3D trajectory or any analog channel 
of data from a C3D file you will want to exercise this option with caution.  Both 
3D Data and Analog data have Parameters associated with specific channels – 
these will need to be updated whenever a 3D trajectory or Analog channel is 
deleted. 

 You must be in 
Edit mode to delete data 
from a C3D file. 

To delete data from a C3D file you must first select the 3D Data or Analog channel 
from the Tree window and then use the Edit menu at the top of the screen to access 
the Delete function.  A warning message will then be displayed: 
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Figure 34 - The C3Deditor will always warn before deleting data. 

If you answer Yes to this message then the data will be removed from the C3D file 
and all remaining 3D Data points or Analog channels will be renumbered.  If you 
made a mistake this is the time to fix it as the Undo button on the toolbar will 
restore the data if necessary. 

 Undo will reverse 
the results of the last 
C3Deditor operation. 

While it’s easy to delete data from the C3D file you may have to edit the Parameters 
to reflect the changes in the file structure.  For example if you are removing an entire 
Force Plate from the C3D file then you will also have to change the Parameters that 
describe the Force Plate and the various ANALOG group Parameters that describe 
the analog channels that have been deleted.  This can become complex and you may 
wish to create a batch file to automate this task if you have several files to repair in 
this manner. 

Filtering 3D Data 
The C3Deditor incorporates a powerful digital filter that can clean up noisy 3D data 
by removing unwanted frequency components in the data.  A typical use for this 
would be to remove high frequency noise from a marker trajectory.  Let’s look at the 
LTOE trajectory in the demo4.c3d file – as you can see there is some noise in the 
vertical (Z) component of data following the event markers HS and IC. 

 
Figure 35 - Raw 3D point data display showing some noise. 

It appears that there is some jitter in the recorded data that we can probably remove 
from the data by filtering. 

The filter menu is accessible from the Tools menu at the top of the C3Deditor 
window or by right clicking on the graphical data display and selecting Filter 3D 
from the menu that appears.  Either method will display the 3D Data filter options: 
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Figure 36 - The C3Deditor can includes a digital filter for 3D Point data. 

The C3Deditor filter can use a FIR digital filter or a digital implementation of a 
Butterworth filter – further information about the FIR and Butterworth filters is 
provided later in this manual.  In each case you can apply one of four types of 
filtering – Low Pass (LPF), High Pass (HPF), Band Pass (BPF) and Band Stop 
(BSF).  Generally you will find that 3D data is filtered with a Low Pass Filter – in 
this case we’re using a Low Pass filter at 6 Hz and filtering the frame selection.  
Options exist to filter the entire frame range (All) or only filter the sections of the 
marker trajectories that have high residuals.  We are also only filtering the single 
marker LTOE which is highlighted in the Channels list on the right. 

The 3D data filter offers the 
option of setting the residual 
of each filtered point to 0.0 – 
this is generally used to 
indicate that the 3D point 
data has been manipulated in 
some way that causes the data 
point residuals to become 
irrelevant.  You may 
optionally leave the point 
residuals unchanged by 
deselecting this option before 
filtering the data. 

Clicking on OK produces the following result: 

 
Figure 37 - 3D Point data after filtering to remove the noise. 

Note that we have only filtered a single trajectory in this operation although we 
could have applied the filter to the entire range of 3D marker channels just as easily 
by selecting the range of channels from the channel list.  The C3Deditor gives you 
the power to quickly modify your data yet you remain in control of the entire process 
at all times. 

If you are not happy with the results of any filter operation then you can use the 
Undo button to reverse the operation.  Remember that the Undo button can only 

The C3Deditor User Guide Tutorial  •  37 



 

“undo” the last data modification so you should check the results before you move 
on to additional changes.  No changes are made to the original C3D file until you 
exit the C3Deditor and save the data – your original file will remain unchanged until 
you overwrite it with a new file.  You can automatically apply filtering to any 3D 
trajectory when the C3D file is first opened by taking advantage of the C3Deditors 
powerful batch mode. 

Interpolating 3D Data 
3D marker data often contains gaps in the data and if you look through the 
trajectories in the demo4.c3d file you will see that there are small breaks in the 
trajectories of two markers RANK (Right Ankle) and LHEE (Left Heel).  The 
C3Deditor can generate data to fill in most small gaps of this type.  Right-click on 
the graphical display and select the Interpolate option to display the control for this 
operation. 

 
Figure 38 - The C3Deditor can interpolate missing 3D points. 

The default is to filter gaps of less than 10 frames – these are small gaps and this 
setting will probably do fine.  Click on the “Interpolate All Channels” box to tell the 
C3Deditor to check for gaps in every 3D marker channel and then click OK.  The 3D 
Data will be interpolated and the gaps filled. Go back to the graphical display and 
examine both RANK and LHEE markers to verify the interpolation.  You can use the 
Undo button on the toolbar to reverse the operation if you do not like the results. 

Filtering Analog Data 
The C3Deditor includes a powerful analog filter using the same FIR filter techniques 
as we used for the 3D Marker Data.  The application also contains a Butterworth 
filter. The analog filter is only available when the C3Deditor is in Edit mode. 

Check that the C3Deditor Frames button is UP (displaying only a single sample from 
each video frame).  Then select the FX1 analog channel in the example file 

 and look at the analog data for this channel. demo1.c3d

The initial view is typical of that of many analog display programs – a single analog 
sample is displayed from each video frame.  The data appears to have some ringing 
around frame 75 but otherwise seems OK. 

However, looking at the Data window in the C3Deditor reveals that the analog data 
in this file has multiple samples per video field.  If you look briefly at the file header 
information you’ll see that the video rate is 60 Hz and that the analog to video ratio 
is 10 – thus the true analog sample rate is 600 Hz. 
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As a result of displaying only a single sample from each video field we are not 
seeing the all of the data.  Now select the Frames mode by clicking on the Frames 
button in the toolbar.  The C3Deditor will now display every single analog sample 
for the selected channel – you will see the analog display expand and a scroll bar 
appear at the bottom of the screen. 

 Select the Frames 
display on the C3Deditor 
toolbar to see every single 
analog sample in the data. 

 
Figure 39 – The standard view of the FX1 raw analog channel in the demo1.c3d file.  

Now let’s scroll through the data and have another look at the analog signal around 
frame 75 and you’ll immediately see a dramatic change in the analog signal that was 
not visible in the previous display!  

It seems that the ringing that appeared at the end of the force plate strike is actually a 
burst of noise in the data that is probably entirely unrelated to the force plate data.  
Examining the other analog channels reveals that this appears to be an interference 
problem that affects only the first force plate. 
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Figure 40 - Raw analog data containing spurious noise. 

This type of noise can easily be removed from the data without any major effect on 
the force plate information.  The noise appears to be very high frequency while the 
majority of the force data is much lower in frequency.   

This demonstrates why it’s essential to evaluate the quality of all analog data by 
looking at every sample in the file – not just a single sample per frame. 

Right-click on either the Data Window or the graphical display to display the tools 
menu and choose the Filter Analog option, which will display the Analog Filter 
options control dialog box: 

 
Figure 41 - The analog filter can be applied to any analog channel. 

Since we want to remove the high frequency noise and leave the slower force plate 
data untouched we will use a Low Pass Filter – so our Filter Type will be LPF.  We 
can choose the filter point and so we will set a relatively high point to filter 
frequencies above 100 Hz.  To start off we’ll just filter the one channel so now 
click on OK to apply the filter at 100 Hz to the FX channel: 

You can also separate the 
noise signal from the force 
data by applying a high 
pass filter at 100 Hz – this 
will show the noise 
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component while removing 
the force component… 

 
Figure 42 - The analog signal after a 100Hz Low Pass filter has been applied. 

The data immediately cleans up as shown above.  If you want to see how the data 
looked before it was filtered (or you are not happy with the results of the filtering 
and want to try again) then just click on the Undo button on the Toolbar to restore 
the analog channel to its previous condition. 

 Use the Undo 
button to return to the 
original data if necessary. 

You can now filter the other channels for this force plate by repeating the filtering on 
the range of channels from FY through to MZ for this plate. 

Changing the Sampling Rates 
It’s easy to change both the basic 3D sampling rate and the analog to video rate by 
using the tools provided with the C3Deditor.  Both features are accessible from the 
Tools menu at the top of the C3Deditor provided that the C3Deditor is in Edit mode. 

These tools are commonly used to adjust two different C3D files so that they both 
have common video and analog rates for comparison by another program that 
requires a particular video frame rate or analog data rate.  Remember when you use 
this feature that no really new data is generated. 

Increasing the sample rates 
simply produces more 
samples from the original 
data.  It does not change the 
frequency components of the 
original data. 

3D marker data 
The 3D (or Video) sampling rate will initially display the Sampling Frequency at 
which 3D data has been recorded.  This can be changed by entering a new value and 
selecting OK.  This will then change the 3D sample rate to match the new rate and 
will adjust the total number of 3D and Analog samples accordingly.   

The analog rate is determined 
by the number of analog 
samples per 3D sample, you 
will be simultaneously 
changing the analog sample 
rate when you change the 3D 
sampling rate! 
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Figure 43 - The sample rate of the 3D point data can be easily changed. 

The new 3D sample rate will be stored in the standard parameter POINT: RATE as 
well as in the C3D file header.  Note that simply changing the locked parameter 
POINT: RATE will not have the same effect as this simply records the rate at 
which data changes in the C3D file – it does not change the data in any way and 
might result in a corrupted C3D file. 

If you make a mistake then 
the Undo button on the 
toolbar will restore the 
original 3D rate and data 
samples.   

Analog Data 
Selecting Analog to Video Ratio from the Tools menu will initially display the 
Analog to Video Ratio, which is the number of analog samples that exist for each 
3D sample.  Like the 3D or Video rate, this can be changed by entering a new 
value and selecting OK. 

Simply changing the locked 
ANALOG: RATE parameter 
will not affect the analog 
data and may result in a 
corrupted C3D file. 

 
Figure 44 - Changing the Analog sample rate is as simple as entering a new value. 

This will then change the number of analog samples that exist for each 3D sample. 
The new effective analog rate will be stored in the standard parameter ANALOG: 
RATE as well as in the C3D file header. 

It is very important to understand that editing the values of the RATE parameters in 
the POINT and ANALOG groups does not have the same effect as actually changing 
the raw data sample rates.  Both of these parameters should normally be locked to 
indicate that they should not be edited.  However some manufacturers applications 
may incorrectly set the parameters as unlocked. 

Changing the Analog Offset 
You can change the values in the ANALOG:OFFSET parameter by using the Analog 
Storage command on the Tools menu.  This command allows you to specify a new 
value for this parameter using the Analog Offset dialog box.  All the analog channels 
will have this new value that you select. 
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If the parameter contains different values of offset for different channels, you will be 
informed of this and will have an option to continue or cancel this operation.  Please 
note that this will not happen if you are making use of this feature in the batch mode 
of the application. 

 
Figure 45: Analog Offset dialog box 

This dialog box has the following fields: 

Choose Value for analog offset 
This field has the value that is present in the parameter at the present time and you 
can enter the new value that you want it to be. 

Appending and Merging Data 
Data from two separate C3D files can be joined together by the C3Deditor.  This is a 
powerful feature that can be used to generate complex C3D files from a number of 
smaller files.  Data can be either appended or merged: 

Appending data to a C3D file means that data from an additional C3D file is added 
to the start or the end of the current open C3D file.  This can be used to construct a 
long C3D file from a number of shorter files.  When an append operation is to be 
performed both the data files must meet the following conditions: 

• Identical data format – either integer or Floating Point data. 

• The same number of analog channels 

• The same number of 3D markers 

• The same 3D sample frequency 

• The same analog to video ratio 

• The units in which marker data is collected should be the same 

Merging data to a C3D file is different from appending data in that a merge 
operation combines selected data from the two C3D files into the same frame range.  
For instance a merge operation could be carried out on two files, one file being a 
subject walking through the calibration volume while the second file could be a set 
of calibration markers captured in a separate data record generated immediately 
before the subject session.  Merging the two files together would produce a single 
C3D file that appeared to contain data from a subject walking through the calibration 
markers without any problems of marker view obstruction. 

Importing Data from Excel 
The C3Deditor can also import data from the Microsoft Excel spreadsheet, which 
gives anyone the ability to create C3D compatible data files from almost any data 
source that can be read into a spreadsheet.  If you chose to install the demonstration 
data supplied with the C3Deditor then the 

You must be able to 
run the Microsoft Excel 
spreadsheet program on 

…\demo directory will contain a sample 
Excel spreadsheet called  that can be used to demonstrate this process.  example.xls

The C3Deditor User Guide Tutorial  •  43 



 

your computer in order to 
import data into the 
C3Deditor. 

The process of importing data into a C3D file requires that we have a C3D file open 
to hold the data.  The standard C3Deditor installation includes a small C3D file 
called dummy.c3d that contains some basic parameters but does not contain any data.  
This is supplied to make the import process relatively easy so that we can import the 
spreadsheet data into an empty file that contains only the basic Parameter 
information.  The basic process for importing 3D data is: 

1. Assemble the data in an Excel spreadsheet in the correct order (X-Y-Z 
columns). 

2. Open the dummy.c3d file in the C3Deditor. 

3. Switch to Excel and select the range of data for a single marker that 
you wish to import into the C3D file and copy it using the right-mouse 
button menu in Excel. 

4. Switch to the C3Deditor and select a marker to receive the data from 
the Tree window.  Right-click in the Data window or the Graphical 
window and select import from the menu.  The data will be imported 
into the selected 3D marker. 

5. Repeat the last two actions until all the data is in the C3D file and then 
save the file under a new name. 

6. Finally use the C3Deditor to create the appropriate Parameters that may 
be needed to describe the data and save the file in the appropriate 
format. 

Analog data can be imported in exactly the same way.  Multiple samples per 3D 
point can be imported as sequential values in a column or by selecting multiple 
samples on a single row in the spreadsheet. 

Remember that you will almost certainly need to either create or modify several 
parameters in the new file to describe the data that you have imported.  This is 
probably easiest if it’s done interactively through the C3Deditors graphical interface 
for an individual file. 

Let’s start by opening the spreadsheet file – use Explorer to select and open the file, 
which will normally be C:\Program Files\MLS\C3Deditor\Demo\example.xls -
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Figure 46 - The C3Deditor can import data directly from Excel. 

As you can see, the data is stored in columns in the order X, Y, Z – this is the order 
that the C3Deditor will expect 3D data.  Analog data may be stored as consecutive 
samples or as multiple samples per line – the C3Deditor will read both analog 
formats.   

The C3Deditor is not limited 
to 3D data.  2D data can be 
imported by simply storing 
zeros in one column of the 
spreadsheet. 

The sample spreadsheet has formatting together with frame numbers and column 
headers – none of this is actually needed for an import operation.  All we need is a 
minimum of three columns of numbers containing co-ordinates in the order X, Y, Z 
per 3D point. 

If you have a number of files to create then you may want to create a batch file to 
automate the process of creating the parameters.  This can save a significant amount 
of time when you have a large number of files to create.  The next section discusses 
the C3Deditor batch mode using some example files that are included with the 
standard installation. 

When you have finished importing the data and have saved the file under a new 
name you will notice that the new is a DEC FLOATING POINT formatted file – 
this is because the original 

The C3Deditor will 
automatically calculate the 
correct POINT: SCALE 
value when data is imported 
from Excel. 

dummy.c3d file was in this format. 

This is significant as it means that the imported data is stored as Floating Point 
numbers and that the POINT: SCALE value has been preset to a special value of –1.  
If you now save your new file as an INTEGER format file the POINT: SCALE value 
will be calculated and saved with a value that is appropriate to the range of data that 
has been imported. 
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If you are creating C3D files from scratch to transfer data into another program such 
as MOVE3D then you may find it easiest to open one of the sample files that is often 
supplied with applications such as MOVE3D.  You can then use the C3Deditor to 
copy the parameters from a known good file into your new file.  This means that you 
will probably only have to edit parameter values rather than creating new parameters 
and groups. 

Automating the C3Deditor 
Many biomechanics and gait laboratories produce larger numbers of C3D files that 
all contain similar data.  In this situation it’s not uncommon to need to perform the 
same type of operation on many different files – a typical requirement might be as 
follows: 

1. Low Pass filter the force plate data 

2. Bandpass filter the EMG channels 1 through 10 

3. Enter muscle descriptions for the EMG channels 

4. Change the EMG channel labels to read "mV" 

5. Remove the unwanted ANALOG: GAIN parameters 

6. Set the FORCE_PLATFORM: ZERO parameter to a reasonable value 

7. Filter the 3D data with a 6 Hz low pass filter. 

8. Interpolate the 3D data to fill all gaps of less than 12 frames. 

9. Create or delete an analog channel. 

10. Create or delete a 3D marker. 

11. Create a SUBJECT Group 

12. Create NAME parameters in the SUBJECT group. 

13. Create SEX parameters in the SUBJECT group. 

14. Create HEIGHT parameters in the SUBJECT group. 

15. Create NUMBER parameters in the SUBJECT group. 

16. Create PROJECT parameters in the SUBJECT group. 

17. Create DOB parameters in the SUBJECT group. 

18. Create a MARKER_DIAMETER  parameter in the SEG group and set 
the value to 25.4mm (or one inch). 

19. Lock the POINT: RATE parameter. 

Clearly if we had to perform these operations on each file we would be spending 
more time editing the data files than generating them!  The C3Deditor makes it easy 
to perform repetitive operations such as these with its built-in batch mode that allows 
you to specify a series of commands in a file.  This sequence of actions can then be 
performed automatically whenever a C3D file is opened. 

A number of sample batch files are included with the C3Deditor that demonstrate the 
power of the batch feature and provide an easy way to build your own batch files.  
The default batch file supplied with C3Deditor is batch.cfg – this file contains a 
series of commands that perform all of the operations described above. 

Let’s start by closing any C3D files that you currently have open in the C3Deditor 
to avoid confusion.  Now use the options menu (available from the File menu when 

The sample batch file 
contains a number of 
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different commands to 
provide filtering, 
interpolation and 
configuration information.. 

no files are open) to select the batch.cfg file as the batch file that contains the 
commands that we want to execute when a file is opened. 

If you have used the default installation for the C3Deditor then the Batch File entry 
should contain the line:

C:\Program Files\MLS\C3Deditor\batch\batch.cfg 

The batch file specifies actions that are to be performed whenever a C3D file is 
opened.  It is a text file and can easily be edited with NotePad, EMACS or any other 
ASCII text editor.  You may want to view it or print it out to follow the operations 
that it performs.  It’s very easy to edit this, or any other batch file, to perform almost 
any sequence of operations.  Examine the sample batch files, supplied with the 
C3Deditor, for detailed examples of individual commands – each command is 
defined in the user manual. 

To demonstrate the power of the batch mode we’ll open one of the demonstration 
files in one window, then turn on the batch mode and open the same file a second 
time.  Since we now have the batch mode ON the commands in the batch.cfg file 
will be executed when the file is opened the second time and we will be able to 
compare the results of the batch operation directly: 

1. Turn the batch mode ON from the file menu by clicking on the Batch 
Mode option in the File menu (a check will appear by the option). 

2. Open the file gaitdata.c3d in the demo directory there will be a slight 
pause as the batch commands are performed. 

3. Now save the new file as gaitdata new.c3d 

4. Turn the batch mode OFF from the file menu by clicking on the Batch 
Mode option again in the File menu (the check will disappear from the 
option).  Any file opened while the batch mode is OFF will not be 
affected by the commands contained within the batch file. 

Now that the batch mode is OFF you can open the file gaitdata.c3d in the demo 
directory again – this time the batch commands will not be performed since the batch 
mode is no longer in operation. 

You can now use the Window Tile command to view both versions of the C3D file 
at the same time – you can browse through the Tree and Data windows and clearly 
see the effects of each of the edits that have been performed when the file was 
opened – for example: 

• The Tree window shows the new SUBJECT group has been created.  
You can view the new parameters in the Data window. 

• The effects of the analog band pass filtering in the EMG channels are 
subtle but clearly show the reduced baseline artifact in during muscle 
activity, particularly in channels E02 and E03 (use the Frame button to 
display every analog sample). 

• The effect of the low pass filters on the force data is more dramatic – 
look at the FY1 signal in both files around frame 151 during the end of 
the signal transition. 

The batch mode is the ideal tool for automating the creation of parameters and large 
scale edits to multiple files.  The default batch.cfg file simply performs the edits and 
then displays the information – no changes are made to the original file.  You can tell 
the C3Deditor to automatically save the results of any batch operation by editing the 
SAVE setting in any batch file.  This allows you to open a C3D file, automatically 
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perform a series of complex changes and then write the new information back to the 
C3D file. 

Verifying the data 
As you’ve probably figured out by now, the C3D file parameters come in many 
shapes and sizes and it can be a complex job to check that every single parameter in 
a file is correct.  The C3Deditor addresses this problem with a file validity checker in 
the Tools menu that allows you to check that any given file contains Parameters that 
meet a criteria that you can specify, 3D Data that lies within the data limits specified 
in the parameters and valid analog data. 

The format of the C3D file parameters is specified in a validity file which contains 
simple text descriptions of the characteristics of the parameters that are expected to 
exist in the C3D file.  You can have several different validity files for each group of 
C3D files.  The default installation of the C3Deditor will place a sample validity 
check file, called valid.cfg, in the program directory.  This contains commands that 
are designed to check the gaitdata.c3d file and report any differences between the 
contents of the file and the data that the C3D file is expected to contain.  We’ll now 
demonstrate this validity check together with the batch processing: 

Start the C3Deditor and open the demonstration file gaitdata.c3d – go to the Tools 
menu and select Validity, then Parameter… This will perform a validity check of 
the parameters in the file, using the information in the default file valid.cfg and report 
and differences between the contents of the file and our expectations.  Any 
differences are reported in the Validity Results window. 

 
Figure 47 - The Validity Results window 

In this case we can see that there are a number of parameters missing from the C3D 
file that are defined in the valid.cfg file.  These are the parameters that we had 
created earlier using the batch file so it’s reasonable to assume that the problem is 
that we do not have any description of the new parameters in our default validity 
check.  Use the Validity check to test the 3D and Analog data – you’ll find that both 
the 3D and Analog data appears to be fine so let’s fix the problems with the 
parameters… 

Close the gaitdata.c3d file and then check that the default batch file that we are using 
is still the batch.cfg file supplied with the sample files.  This can be checked from the 
File menu using Options. 

Set the batch mode ON – a check will appear by the File menu option displaying the 
current Batch Mode selection.  Any file that is opened will be processed by the batch 
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commands so let’s open the gaitdata.c3d file again and run the validity check on the 
parameters after the batch edits have been performed.  This time the Validity Results 
window will not display any errors – you can browse through the parameters in the 
Tree window and see the changes that have been made to update the C3D file 
contents. 

However, if you now run the Validity checks on the 3D data you’ll find that the 
filtering performed in the batch file has changed the 3D coordinates very slightly and 
the Validity check will now report that the 3D data is out of limits for five of the 
markers.  This is because the SEG: DATA_LIMTS parameters for positive X were 
very close to the data before the filter operation – we can fix this minor problem by 
quickly editing the + X value in SEG: DATA_LIMITS to 3550 (it’s the 4th item in 
the data array).  If this type of report is generated frequently then you may want to 
change the DATA_LIMITS parameters used to collect the coordinate information. 

Scaled Data vs. INTEGER Data 
Data can be stored in the C3D file in two basic formats – as FLOATING POINT 
numbers or as INTEGER numbers that are scaled to produce FLOATING POINT 
numbers.   

• A FLOATING POINT number is stored as a floating point value that 
has a decimal component – the following are examples of FLOATING 
POINT numbers … 3.14792, -1.5262, 2.0000 etc. 

• An INTEGER number is stored as a value without a decimal 
component – the following are examples of INTEGER numbers … 
3627, -62, 1 etc. 

Two of the common C3D file formats are the DEC INTEGER and INTEL INTEGER 
formats which store the 3D data as INTEGERS.  Since data rarely comes in exact 
values the C3D file contains a scale factor that is a REAL value which is used to 
produce the exact “real-world” value when applied to the stored INTEGER values. 

The C3Deditor can read and write 3D data in both FLOATING POINT and 
INTEGER formats and can display both the INTEGER values and the FLOATING 
POINT values depending on the state of the Scale button in the toolbar.  In general 
you will want to select the FLOATING POINT scaled data when you are looking 
at 3D marker positions and the INTEGER data when you are looking at the analog 
samples.  The C3Deditor will remember the selections that you use for each data 
type and apply them automatically when you select the data for viewing or editing. 

 The setting of the 
Scale button in the Toolbar 
controls only the displayed 
format of the data – it does 
not change the data. 
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Using the C3Deditor 

The workspace 
When the C3Deditor is installed it will make an association with the C3D files that 
will allow you to start the C3Deditor directly from the Windows Explorer by 
“double-clicking” any C3D filename with the mouse. The C3Deditor allows you to 
open several C3D files at once and edit each file separately. Each C3D file will be 
opened in its own workspace window and the data and parameters in each file can 
be manipulated and edited separately. This can be a very useful feature when you 
are trying to compare the contents of two separate C3D files or copy information 
between them. 

  
You can also start the 
C3Deditor from the desktop 
icon… 

The workspace of the C3Deditor is split into two panes: 

• The Main View which is displayed on the left side of the workspace. This is the part of the workspace in which you 
can view the different components of the C3D file and also perform edit and selection operations. 

• The Graphical (or Scroll) View on the right side of the workspace. This is the part of the C3Deditor workspace 
which allows you to view the graphs of the Analog and 3D data. 

At any given time, one of these two panes will be selected by C3Deditor.  This will 
be shown in the status bar at the lower right side of the C3Deditor windows as shown 
in Figure 48, where the Main View is the active view.  When a C3D file is open this 
status indicator will either display MAIN VIEW or GRAPHICAL VIEW. 

 
Figure 48 – The Status Bar showing Active view 

You can select which side of the C3Deditor workspace is “active” by clicking on the 
desired side with your mouse. Each side (MAIN or SCROLL) has its own set of 
commands that are only active when that particular view is selected. 

In addition, the right side status indicators will display the current settings of the 
NUM LOCK and CAPS LOCK keys. 

The Main View 
The view to the left of the C3Deditor window is called the Main View while the 
view on the right is called the Graphic View. The Main View has three windows that 
allow you to view the contents and structure of the C3D file – these are: 
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The C3D structure – Tree Window 
This is an interface similar to the one found in the Windows Explorer. It is called a 
“tree control” and it allows you to view the contents of the C3D file as a tree that 
contains branches that can be expanded – much like the common Microsoft directory 
structures that you are familiar with in the Windows operating systems.  

 
Figure 49 – The C3D tree view 

The tree is an especially easy way to view the relationships between the groups and 
the associated parameters and data values. In the example shown the group “point” 
has ten parameters such as USED, FRAMES etc. Each parameter will have at least 
one value associated with it – some parameters (such as LABELS) may have 
several values associated with the parameter name. 

Throughout this manual we 
will use UPPERCASE 
names to indicate that we 
are referring to a C3D 
group or parameter. 

The displayed C3D tree will contain the following items: 

Header Information 
This will always be present and contains the contents of the C3D file header block in 
an easy-to-understand format together with some other values of interest. This 
header block contains important information and is present in all C3D files. The data 
present in this item cannot be edited directly but you can edit those items that have 
parameters – such as the Scaling Factor and the Sample Rate etc.  The header will be 
updated when the parameters change or the file is saved in a different format. 

Analog Data 
This will always appear, even if the C3D file does not contains any analog data. 
When analog data is present this displays all the analog channels that have been 
collected. It is displayed as 

n<name> 

where, n is the channel name and name is the label associated with the channel. This 
label is obtained from the parameter ANALOG: LABELS. If any analog channels are 
present, they will be displayed as sub-items below the analog data and will show the 
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analog channel number and parameter LABEL values. This usually makes it easy to 
figure out which analog signal is associated with any analog channel. 

3D Data 
This will always be present. This item shows all the 3D Marker data that has been 
collected. It is displayed as 

n<name> 

where, n is the channel name and name is the label associated with the channel. This 
label is obtained from the parameter POINT: LABELS. If any 3D marker data has been 
collected, it will be displayed as a sub-item of the 3D Data. Like the analog data each 
3D item will have a trajectory number and a parameter LABEL value making it simple 
to see the relationship between a point trajectory and the LABEL that has been 
assigned to the point. 

Groups 
Every parameter that is present in a C3D file belongs to a group. In the initial view 
of the C3D file contents the C3Deditor will simply display the group names. These 
displayed group names will usually have parameters that belong to a group that 
will appear as sub-items. In other words, the initial view will be that of the group. 

When referring to a group 
and parameter we will 
separate the two values with 
a colon so that a group 
parameter name will appear 
thus – GROUP: 
PARAMETER 

When you double-click on the group name the group will expand downwards to 
display the parameters, which will appear as sub-items to the group. Double-click on 
the group name a second time to hide the parameters. Thus you can quickly navigate 
through the C3D file contents in a very natural manner that mimics the normal 
Windows directory navigation. 

The C3D Data Window 
The window below the Tree window displays the values of the currently selected 
item in the Tree (if any). The values and various data items are arranged in rows and 
columns. This window is used to display the contents of the C3D file header as well 
as the individual group, parameter and data items. Each of these data items (with the 
exception of the C3D header) can be edited from within this window. 

The appearance of this window will change slightly depending on the type of data 
that is displayed. Some displays (such as the one shown below of the header 
information) are simply shown for information only whereas other displays of 
analog sample values and parameter information may be edited directly by 
selecting an item with the mouse. 

You must have checked the 
“Edit mode” box in the Edit 
menu before the C3Deditor 
will allow any operations 
that change information in a 
file. 
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Figure 50 – The C3D header information 

The C3D Data window is the primary editing interface that allows you to change the 
contents of the C3D file – any group, parameter or data item can be modified from 
this window. 

The different types of data that can be displayed in the Data windows are: 

C3D Header 
The C3Deditor displays header information from the current C3D file in the data 
window together with other useful information. For simplicity, it does not display 
every byte of information in the file header. It is important to note that some items 
in the file header may change if the file is saved in a different format or if anything 
is done that might change the size of the parameter header. 

The C3D header display 
will always show the 
original contents of the 
header when the file was 
opened. 

The items displayed in the Header Record are: 

• Parameter Record - the record number of the first record containing 
Parameters. 

• 3D Points - this is the number of 3D Marker channels that have been 
collected. 

• Analog Channels - this is the number of Analog channels that have 
been collected. 

• First Frame - this is first frame of data present in the file. 

• Last Frame - this is the last frame of data present in the file. 

• Maximum Interpolation Gap - This (optionally) sets the largest gap in 
the data that may be interpolated. 

• Scaling Factor - this is the value by which the integer 3D data is 
multiplied to get scaled data and is the same as the value found in the 
parameter POINT: SCALE. If this value is negative the data is stored in 
FLOATING POINT format and the scaling factor has already been 
applied to the data. The original scaling factor is preserved, as it is 
required to interpret the 3D data residuals. 
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• Data Start - this sets the first record at which the 3D and/or analog data 
are stored. Any discrepancies between the Data Start value recorded in 
the C3D file header and the parameters will be corrected when the C3D 
file is saved.  This is the same as POINT: DATA_START, which may 
be edited. 

• Sampling Rate - this is the rate at which the 3D data is sampled. 

• File Format - this field displays the format of floating point (REAL) 
values within the C3D file - INTEL, SUN or DEC. This is not actually 
stored in the C3D file header but shown here for reference. 

• Data Type - this field displays the numerical format in which the data is 
stored, i.e. Integer or Floating Point (floating point) format.  This is not 
actually stored in the C3D file header but shown here for reference. 

• A to V Ratio: This field shows you the Analog to Video ratio, i.e. the 
number of analog samples collected per frame of video. 

• Nyquist Frequency:  This field shows you the Nyquist frequency of the 
analog data collected.  This is half the analog sampling frequency. 

Analog Data 
When analog data is displayed in the data window in the C3Deditor, the first column 
shows the frame number and the second column displays the analog sample value 
for that frame. Additional columns (if present) will display additional analog 
samples when there are multiple analog values per video sample (use the scroll bars 
if necessary). The LABEL associated with the analog channel will also be shown 
above the data. 

The values shown for each 
analog sample can be 
displayed as either unscaled 
(integer) values or scaled 
(floating point or Floating 
Point) values by using the 
toolbar Scale button. 

 
Figure 51 – Analog data in the numeric view 

You can edit the individual analog samples by double-clicking on the sample that 
you which to change and entering a new value.  The C3Deditor must be in Edit 
Mode (the edit button on the toolbar will be down) before you try and select any data 
to edit. 
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3D Data 
When 3D data is displayed in the C3Deditor data window, the first column shows the 
frame number. The remaining columns display: 

• The X coordinate value of the marker at the given frame. 

• The Y coordinate value of the marker at the given frame. 

• The Z coordinate value of the marker at the given frame. 

• The residual at the given frame. This is normally the average value of 
the residual from all the cameras that were used to reconstruct the 
point.  The value is stored in the C3D file with each 3D sample. 

• The binary camera mask, which shows you which of up to seven 
cameras observed a 3D point. A 1 indicates that a marker was seen by a 
camera while a 0 indicates that it was not seen. The left most value 
represents the first camera. 

 
Figure 52 – 3D data in the numeric view with residual and mask information 

The values shown for each video sample can be displayed as either unscaled 
(integer) values or scaled (floating point or Floating Point) values by using the 
“Scale Data” button on the C3Deditor toolbar. 

Any data within this window can be edited by placing the mouse on the item that you 
want to change and double-clicking with the left-mouse button.  The item will then 
be highlighted and a new value can be entered.  You cannot change the Camera 
Mask value although editing the Residual is permitted – note that a negative residual 
value will be considered an invalid co-ordinate.  The frame number cannot be 
changed under any circumstances. 

The C3Deditor must be in Edit Mode (the Edit button on the toolbar will be shown 
down) before any data can be selected for modification.  Any edits performed when 
the C3Deditor is not in Edit Mode will not be saved. 
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Groups 
When a C3D file group is selected in the upper tree navigation window the following 
information is displayed in the data window below: 

• Name: This is the name of the group. No two groups can have the same 
name. 

• Number: This is the group number. No two groups can have the same 
group number.  Group numbers are always negative thus tagging the 
item as a group name and not a parameter name within the C3D file. 

• Description: An optional description of the contents of the group. 

• Locked: This will contain a TRUE or FALSE value, which will 
indicate that the group is locked (TRUE) or unlocked (FALSE). It is 
generally not recommended that novice users edit any locked items 
within a C3D file. Great care should be taken while editing the contents 
of a locked group. 

 
Figure 53 - The Parameter Header 

Parameters 
The data window display for parameters is very similar to that of the group with the 
addition of the data items contained within the parameter. Some parameters may 
have a great many data items in which case you will have to use the scroll bars to 
view all of the parameter values. 

 
Figure 54 - The  Parameter editor 

When a parameter is selected the following information is displayed in the data 
window: 

• Name: This is the name of the parameter. No two parameters within a 
group can have the same name. Parameters in different groups may 
have the same name in which case they will be treated as unique 
parameters that can be assigned completely separate values. 
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• Number: This is the parameter number. This number identifies the 
group that owns the parameter.  This number will be the positive value 
of the group number. 

• Description: An optional description of the contents of the parameter. 

• Locked: This will contain a TRUE or FALSE value which will indicate 
that the parameter is locked (TRUE) or unlocked (FALSE). It is 
generally not recommended that novice users edit any locked items 
within a C3D file. Great care should be taken while editing the contents 
of a locked parameter as it may destroy the integrity of the data. 

• Data Type: This will show you the type of data contained within the 
parameter. The possible data types are CHAR, BYTE, INTEGER and 
FLOAT. 

• Dimensions: This field will tell you the number of dimensions present. 
If this number is zero, the data is scalar data. A parameter with data 
type CHAR must have at least one dimension. This is because the first 
dimension determines the length of each data item in the parameter. 

• Dimension [n]: There will be n parameters, one for each of the n 
dimensions where n is any value between 1 and 7. 

• Data [m]: This is the data found in the parameter. Again there will be m 
entries, one for each data item. 

Parameter data can be edited at any time by double-clicking the item in the data 
window with the left-mouse button.  This will display the Parameter editing window, 
which allows you to change any data or property of the parameter.  If there are a lot 
of items in the Data window then you may have to use the scroll bars to see 
everything. 

The C3Deditor must be in Edit Mode before any group or parameter information can 
be modified (the toolbar Edit button will be down when Edit Mode is selected).  If 
the C3Deditor is not in Edit Mode then selecting any group or parameter will have 
no effect and the Parameter Editor window will not appear. 

 

 
Figure 55 - The Parameter Editor window 
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Events 
The standard C3D file can store up to 18 events in the C3D file header. These are 
displayed in the event data window to the right of the Tree window. This window 
displays any event data present in the C3D file header but does not recognize any 
event data stored as parameters or as a Label and Range item.  Label and Range 
Events will be supported a future version of the C3Deditor. 

 
Figure 56 – The Event data window 

If the C3Deditor is in Edit More then you can edit any events stored in the C3D file 
header by clicking on the event data window with the mouse.  This allows you to 
edit, add and delete events, provided that the C3Deditor is in Edit Mode (Edit button 
down on the toolbar).  You can select an individual event to edit by double-clicking 
on the desired item and add additional events up to a total of eighteen.  If there are 
fewer events than this, the last entry in this box will be Add… - if you double click on 
this you will be presented with the Event dialog box which enables you to edit and 
delete the events. 

 
Figure 57 – The Event Dialog box 

Each event contains a four character label together with the time in seconds from the 
start of data collection at which the event occurred and the status of the event (either 
ON or OFF). 

The event will be stored in the C3D file header as a time from the start of the data in 
the file.  However, you can enter the event timing as a time (in seconds and decimal 
fractions of a second), a 3D frame number or and Analog sample number.  Entering 
the event timing as any one of these items will automatically display the event timing 
in each of the data entry boxes. 

When the event "status" is 
selected, a vertical dotted line 
will be drawn on the 
graphical displays to indicate 
the event position. You may 
select the line color via the 
views tab in the "options" 
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dialog. 

The Graphical View 
This window on the right hand side of the C3Deditor displays the analog and 
trajectory data graphically. 

Analog data is displayed one graph at a time with the data automatically scaled to fill 
the defined graph area (set by the options). The maximum and minimum values of 
the data are shown by the side of the rectangle. The scale is selected automatically so 
that all the available data is displayed. 

3D data is displayed three graphs at a time - one each for the X, Y and Z coordinates. 
The maximum and minimum values of the data are shown by the side of the 
rectangle and are selected automatically to display the entire range of data. 

Double clicking inside any 3D or Analog graph will cause a dotted line to be drawn 
at that point and the C3Deditor will show the frame on which you clicked under the 
rectangle. This frame is the selected frame. You can choose a range of frames by 
holding the CTRL key down while double clicking (This can be done only if one 
frame has already been selected). 

Since this is a Frame based 
function this procedure only 
works for Analog data when 
the display is NOT set to 
show sub frames of data. 

When a frame has been selected in the above manner a small rectangle appears at 
the point of intersection of the dotted vertical line and the value of the variable at 
that frame. If you click inside the rectangle, you can change the value by moving 
the rectangle with the mouse button held down.  

Only unscaled graphical 
data can be edited in this 
manner. 

 

 
Figure 58 – The Graphical view - Fz force data shown unscaled. 

Both analog and 3D data values may be displayed in either their scaled values or 
actual stored integer form depending on whether the Scale Data command (View 
menu) has been selected. If the data in the file is already scaled (FLOATING POINT 
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data) then the unscaled values will be those values that would be stored if the data 
was saved as an INTEGER file. 

It is worth noting that analog data that contains a large number of  sub-frame samples 
(i.e. a high sample rate) can look radically different when every sample of data is 
displayed.  This is because the act of displaying data at one sample per frame is 
effectively performing a Low Pass filtering of the raw data and so any frequency 
component higher than the video frame rate will be hidden until every sample of data 
is displayed. 

If there are events present in the C3D file and their status is ON, they will be drawn 
in the graphs as a red dotted line. Their label will be displayed above the graph. 

Customizing the Graphical View 
The way in which the data can be viewed in the Graphical view of the C3Deditor is 
controlled by a number of options discussed in the sections below. 

Viewing Analog Sub Frames 
It is possible that the sampling rate of analog data is greater than that of 3D data. The 
ratio between the sampling rates of the two is the “Analog to Video Ratio” that is 
displayed in the C3D Header window. This ratio is always a whole number. Thus 
there can be more than one analog frame per video frame. This is referred to as sub 
frames in the documentation. 

This command is available only when an analog channel has been selected. 

These sub frames can be shown by selecting the Show Analog Sub Frames 
command (View menu). When this command is selected (as seen by a check mark 
next to it), the sub frames will be displayed.  Show Analog Sub 

Frame 

Viewing Scaled Data 
The analog and 3D data is stored as a series of 16-bit integer values when it is saved 
in an integer file. Even when the data is stored in a Floating Point (or floating point) 
file, only the 3D data is stored as scaled data. The analog data is stored as the 
original sampled analog values and still needs to be multiplied by the various analog 
scale factors before it can be viewed as the original sampled data values. 

The C3Deditor allows you to view data as either integer (unscaled) or Floating Point 
(scaled) values. For analog data, the scaled value is obtained as, 

Gen_Scale*Scale*Offset)(Raw_DataaScaled_Dat −=  

where, 

• Offset for each channel is found in parameter ANALOG: OFFSET. 

• Scale for each channel is found in parameter ANALOG: SCALE. 

• GEN_SCALE for all channels is the same value and is found in parameter 
ANALOG: GEN_SCALE. 

 

For 3D data, the scaled value is obtained as, 

Scale*Raw_DataaScaled_Dat =  

where, 
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• Scale for all markers is the same and is found in parameter POINT: SCALE. 

This is applicable to both the Main View and Graphical View within the C3Deditor. 

The data can be displayed as either scaled or unscaled data in both the numeric data 
window and the graphical data window by setting the Scale Data command (View 
menu). When this command is selected (as seen by a check mark next to it), the 
data will be scaled. 

 View Scaled Data  

The Scale button is applied separately to Analog and 3D data – the C3Deditor will 
always remember the last Scale selection for either type of data and use it when 
appropriate.  Thus setting the data to Scaled when viewing 3D information will not 
affect the display of Analog information. 

Note that the Scale button is disabled when viewing a file that contains data stored in 
the FLOATING POINT format, as the data within these files is always stored in a 
scaled format. 

Selecting the graph size 
You can set the size of the graph that will be used to display the data in the 
Graphical View. This can be done using the Scales command (View menu). This 
opens the Graph Scales Dialog box in which you set the graph sizes.  Change the graph 

size 

This command is available only when the Graphical View is the active view. This 
can be done by clicking inside the Graphical View window on the right side of the 
C3Deditor display. The Graph Scales Dialog box is shown in Figure 59. 

 
Figure 59 – The Graph Scales Dialog Box 

This dialog box has two identical sections, one for analog data and one for 3D data. 
Each of these sections has the following fields applicable to the data: 

• Distance between Frames - This is the distance between successive 
frames in pixels (1/100ths of an inch). You must enter whole numbers 
in these boxes. 

• Vertical Size of Graph - This is the vertical size of each graphical data 
display. The C3Deditor indicates the minimum and maximum values 
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for this setting – 3D data is always displayed as three graphs (X, Y, and 
Z) so a larger value is allowed for analog data in this instance. 

Toolbars 
The C3Deditor displays a toolbar at the top of the screen, which allows you to select 
many common menu commands at the click of a mouse button.  In addition, the 
status of commands that can be toggled – for instance, the Edit, Frames, and Scale 
buttons – will be displayed on the toolbar by showing the buttons as either up (OFF) 
or down (ON).  Some buttons on this bar will not be active until certain conditions 
are met.  For example, the IMPORT button is only available when data has been 
highlighted and copied within an Excel spreadsheet, while the DELETE button is 
only available when a range of data has been highlighted in the graphical window. 

The Toolbar command (View menu) can be used to display and hide the Toolbar, 
which includes buttons for some of the most common commands in C3D Editor. A 
check mark appears next to the menu item when the Toolbar is displayed. 

In addition to toolbar 
buttons you will also see 
“tool-tips” that pop up 
when the mouse moves over 
a button. 

The following buttons are available on the toolbar along with the associated menu 
command. 

 
Open command (File menu) 

Select and open a C3D or DST file for viewing or editing.  
Save command (File menu) 

Save the current C3D file to disk.  
Print command (File menu) 

Send the data in the file to the current default printer. 

Edit Mode command (Edit menu) 

Click on the button to toggle between editing and non-editing modes. 

Undo command (Edit menu) 

Use this to undo the last action performed. 

Delete command (Edit menu) 

Delete the current selected item. 

Copy command (Edit menu) 

Copy the selected item to the clipboard. 

Import command (Edit menu) 

Import ASCII column data from an Excel Spreadsheet into 3D or Analog data. 

Show Analog sub Frames command (View menu) 

Display every sample (sub frames) of the analog data in the graphic window. 

Scale Data command (View menu) 

Toggle between displaying as scaled and unscaled values. 

Change Graph Display option (View menu) 

Change the graph scales used to plot data in the Graphical View 
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About command (Help menu) 

Display the current version and registration information. 

SHIFT+F1 

Point and click for context sensitive help. 

Status Bar 
The C3Deditor can display a status bar at the bottom of the editor window. The 
Status Bar command in the View menu can be used to display and hide the Status 
Bar.  This provides useful information during the editing of files and some status 
information.  A check mark appears next to the menu item when the Status Bar is 
displayed. 

The left side of the status 
bar describes the menu 
items as you use the arrow 
keys to navigate through 
menus as well as describing 
the actions of toolbar 
buttons as you select them. 

 
Figure 60 – The C3Deditor status bar. 

The right side of the status bar contains three panes.  These are: 

Active View Pane: This pane shows you the active view of the C3Deditor as either 
Main View or Graphical View. 

• CAPS Lock: This pane shows you if the CAPS lock key is depressed. 

• NUM Lock: This pane shows you if the NUM lock key is depressed. 

Pop Up Menus 
To make the C3Deditor user friendly and easy to use, many of the commands that 
are required are available from pop up menus. 

These menus are activated when you right click with the mouse in a particular 
window or area of the screen. These menus list all the commands from the Tools 
menu to make it easier for you to choose these items. 

Batch Mode 
An extremely powerful feature of the C3Deditor is that it is possible to work with 
the program in a batch-processing mode. In this mode the C3Deditor reads 
commands one by one from a text file and performs the operations, in sequence, on 
the C3D file. The file can then be saved and closed. This allows you to configure a 
set of common commands, such as adding labels to EMG channels and filtering the 
data, which are automatically performed without any effort on the part of the user. 

It is important to note that 
the batch commands are 
performed in sequence as 
soon as a C3D file is 
opened. You must have 
selected the batch mode 
prior to opening a file. 

The command to put the C3Deditor in batch mode is the Batch Mode command (Edit 
menu). When it is in batch mode the C3Deditor will perform the predefined “batch” 
operations on each C3D file that it opens. These batch commands are stored in a text 
file that we shall call the batch file. The name and location of this file can be 
specified in the General Property Page, obtained by selecting the Options command 
(File menu). 
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The application can also be put in the batch mode when it starts up by starting the 
application with the -b switch. 

The following operations can be specified in the batch file, 

• Filtering data – individual filter characteristics can be set for each 
channel or group of channels. 

• Changing the sample rate of the 3D data and or the analog sample rate. 

• Interpolation of 3D data. 

• Creation and removal of analog channels. 

• Creation and removal of 3D markers. 

• Creation of C3D groups and parameters. 

• Removal of C3D groups and parameters from the file. 

• Modification of C3D groups and parameters. 

• Save the C3D data file in any supported format. 

When a file is opened in batch mode, either choosing the Open command (File 
menu), dropping it into the C3Deditor workspace or by double clicking in the 
Windows Explorer (if associated with this C3Deditor), all of the specified operations 
are performed. 

The Batch File is a text file, which contains any operations that need to be performed 
on the files opened when the C3Deditor is in Batch Mode. 

Registration 
The C3Deditor can work in two modes – the evaluation mode and the registered 
mode. The application cannot save more than 100 frames when it is in the evaluation 
mode. You can check if the C3Deditor is in the evaluation mode by choosing the 
About command (Help menu), which will open the About Dialog box of the 
C3Deditor. 

The Evaluation mode is intended to allow anyone interested in purchasing the 
C3Deditor to fully evaluate the application before making a decision about its 
suitability for the environment in which you work. It is not intended to be used 
continuously as an Evaluation Copy.  

Contact Motion Lab 
Systems web site at 
http://www.motion-labs.com 
or via email at 
sales@motion-labs.com.

Entering Registration Information 
You can enter registration information by choosing the Registration command (Help 
menu). This opens the Register dialog box, where you can enter the information that 
you would like to see in the About box of the application. The user name and the 
user organization that you would like to see should be specified before you receive 
your registration number. If these values do not match, the application will assume 
that you are using an Evaluation copy and will not allow you to save any file with 
more than 100 frames of data or view more than the first 8 channels of data. 

If you can not enter the 
Registration information or 
te application remains in 
evaluation mode after 
information has been 
entered then you should 
check that you have entered 
the information exactly as 
specified in your software 
license. 
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Figure 61 - The Registration dialog box - you must enter your license information here. 

 

Windows NT and Windows 2000 
Some users may have problems registering the software on an NT (or Windows 2000 
Professional) machine and find that they have to enter the registration details every 
time that they run the software unless they log in as "administrator".  This is due to a 
security feature with Windows NT and Windows 2000 where registry values are 
created with permission attributes.  The system administrator, or any user logged in 
with administrator privileges can fix this problem as follows:  

6. Log into the computer with administrator privileges and run 
c:\winnt\system32\regedt32.exe to start the administrator registry 
editor.  

7. Locate the HKEY_LOCAL_MACHINE in the Local Machine window.  

8. Locate the SOFTWARE key and expand it.  

9. Locate the MLS key and highlight it - select the Security option - this 
causes a drop menu to appear with three options - select the 
Permissions option. This will open the Registry Permissions dialog 
window.  

10. Select the "Everyone" permission (Windows NT) or the "Users" 
permission (Windows 2000) and change it to allow "Full Control" or 
create permission for "Domain Users" with the "Full Control" access 
rights.  

Repeat this operation for  the same key in HKEY_CURRENT_USERS.  Note that 
Windows NT and Windows 2000 have slightly different descriptions for the registry 
controls.  When using Windows NT you should select the option to "Replace 
Permissions on Existing Subkeys" while Windows 2000 Professional users should 
select the option to "Allow inheritable permissions from parent to propagate to this 
object" 
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Managing Files 

File menu commands. 
This chapter will take you through the standard operations that you can perform on a 
file such as opening a file, closing a file etc. It will not go into any of the processing 
or editing methods, which will be left to later chapters. 

Opening a file 
A data file needs to be opened by you before any editing of the file can be done. A 
file can be opened using the Open command (File menu). This command can be 
used to open an existing file with the C3D extension.  Shortcut : CTRL + 

O 

The C3D data file can contain either INTEGER or FLOATING POINT formatted 
data in one of the following formats: 

• DEC (VAX/VMS or RSX-11M) 

• INTEL (Windows or MSDOS) 

• SUN (SGI workstation)  

The C3Deditor automatically determines the correct format of the file and reads the 
data from the file. This file can then be edited or processed using the other 
commands in the C3Deditor and may be saved in any of the supported formats. 

A file can also be opened by dropping it into the C3Deditor workspace or by double 
clicking on it in the Windows Explorer. This later operation requires that the C3D 
file type is associated with the C3Deditor in the system registry – this is done when 
the C3Deditor is installed. 

The C3Deditor also stores 
the names of the four most 
recently opened files and 
displays them in the File 
menu. You can open these 
files quickly by clicking on 
their name in the menu. 

Reading data from a DST file 
It might sometimes be required to save the analog and/or 3D data to a text file and 
process it using Visual Basic or some other tools that you might possess. It would 
then be convenient if the C3Deditor would allow you read that data back into the 
C3D file you saved it from. C3D Editor allows you to do just this. 
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You need to first save the data to separate DST files using the Save Analog Data 
command (File menu) and Save 3D Marker Data command (File menu) respectively. 
This enables you to manipulate each set of data separately and keeps the file sizes 
manageable. 

After running your own programs you can then transfer the data back into the C3D 
file using the Read From DST command (File menu). Choosing this command opens 
the Read DST dialog box from which you can choose either the analog or 3D 
channels to be read and the DST file that contains the modified data that you have 
manipulated. 

 

Figure 62 – The Read DST dialog box 

This is how to do this: 

1. Choose the Read From DST command (File menu). This opens the Read 
DST dialog box. Complete the following steps in the dialog box. 

2. Choose the type of data to be read, i.e. Analog or 3D from the Data 
field. 

3. Choose the appropriate DST file by clicking on the DST File button. 

4. Select one or more channels from the Channels field. 

5. Choose OK to read the data from the DST file or Cancel to cancel the 
operation. 

Note that the C3Deditor looks for a label in the DST file, which is identical to the 
one present in the C3D file for the channel or channels selected by you. If it’s not 
present then the data will not be read into the new file. 

Closing a file 
An open data file can be closed using the Close command (File menu). This 
command closes all windows containing the active file. C3D Editor suggests that you 
save changes to your document before you close it. If you close a document without 
saving, you lose all changes made since the last time you saved it. 

If any files are open and contain modified data when you exit the C3Deditor they 
will be automatically saved. 
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Saving files 
The Save command (File menu) can be used to save a modified file. This command 
saves the file to its current name and directory. If you want to change the name and 
directory of an existing document before you save it, choose the Save As command 
(File menu). 

 Shortcut : CTRL + 
S 

Saving a file to a New name or Location 
The Save As command (File menu) can be used to save a file to a new name or 
location. 

This command causes the standard Windows Save As Dialog box to open. In the 
dialog box you can specify the new name and location. You can also change the 
format in which the document is saved. You can choose any format which is a 
combination of platform (INTEL, DEC or SGI) and Data format (Integer or Floating 
Point) from the Save As Type field. The present file format will be the one selected 
by default. 

When you use the command, the original file will be closed without any changes 
being saved to it and the changes will be saved to the new filename that you specify. 
This file will now be the open file. 

Saving data to an ASCII File 
The contents of most C3D files can be divided into three types: 

• Parameter Data 

• Analog Data 

• 3D Data 

Each of these types of data can be separately saved to a text file as explained in the 
sections below. This is provided mainly as a means of debugging problems that you 
might have with information within a C3D file but can also be used to generate 
ASCII files that contain complete copies of every piece of information within a C3D 
file. 

Saving Parameter Data 
The Save Parameter Data command (File menu) can be used to save the Parameter 
Data to an ASCII file. C3D Editor displays the Save As dialog box so you can name 
your file. The default name it gives you is the original file name with a p appended to 
it. 

The application allows you to save the parameter data to a DST file or a DES file. 

When saved as a DES file, the format is similar to that in which the parameters are 
saved in the C3D file. 

When saved as a DST file, the groups and the parameters are saved in a file with a 
format similar to the DST file.  Each group and parameter is saved as a single item. 
Each section begins with a group or parameter name preceded by an exclamation 
mark (!). The lines that follow contain the definition of the group or parameter. 
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Storage of Groups 
An example of a group that is stored is given below. The group name, description, 
number and information whether its status (locked or unlocked) is stored in 
consecutive lines. 

 
!POINT 
3-D point parameters 
Number = -1 
Not Locked 

Storage of Parameters 
An example of a parameter that is stored is given below. The parameter name, 
description, number and status (locked or unlocked), data type, dimensional 
information and the actual data are all stored in consecutive lines. 

 
!X_SCREEN 
Lab. axis along X-screen axis 
Number = 1 
Not Locked 
Data Type = CHAR 
Number of Dimensions = 1 
Dimensions : 2  
+Y 

Saving Analog Data 
The Save Analog Data command (File menu) can be used to save the Analog Data to 
an ASCII file using the Save As dialog box so you can enter a filename.  The data is 
always saved as scaled values. 

The default name is the original file name with a z appended to it. Data can be saved 
in one of the following file formats, chosen from the Save as Type field. 

• CSV File - The Analog data is stored with one column allotted to each 
channel. Each column is separated by commas. The number of rows is 
equal to the product of the number of frames collected and the analog 
samples per sample of video. 

• TXT File - The Analog data is stored with one column allotted to each 
channel. Each column is separated by tabs. The number of rows is equal to 
the product of the number of frames collected and the analog samples per 
sample of video. 

• DST File - The Analog data is stored in a file which has a structure based 
on the CAMARC DST format. Data from each channel is stored together 
with the channel names preceded by an exclamation mark (!). From version 
2.52 all the analog data is output in a single column.  In older versions there 
were as many columns as there are analog samples per video sample and the 
number of rows were equal to the number of frames of data collected.  The 
application will be able to read back the data in either format. 

Saving 3D Data 
The Save 3D Marker Data command (File menu) is used to save 3D Marker Data to 
an ASCII file. The C3Deditor displays the Save As dialog box so you can name your 
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file - the default name is the original file name with a v appended to it. The data is 
always saved as scaled values. 

The data can be saved in any one of the following file formats, which can be chosen 
from the Save as Type field in the Save As dialog box which opens, 

• CSV File - The 3D Marker data are stored with four columns allotted to 
each marker, one for each of three coordinates, X, Y and Z and one for 
the residual and camera mask in the C3D file. Each column is separated 
by commas - the number of rows is equal to the number of frames 
collected. 

• TXT File - The 3D Marker data are stored with four columns allotted to 
each marker, one for each of three coordinates, X, Y and Z and one for 
the residual and camera mask. Each column is separated by tabs. The 
number of rows is equal to the number of frames collected. 

• DST File - The 3D data is stored in a file which has a structure based 
on the CAMARC DST format. Data from each channel is stored 
together with the channel names preceded by an exclamation mark (!). 
The following lines contain the data - there are three columns, one each 
for the X, Y and Z coordinates. The number of rows is equal to the 
number of frames of data collected. 

Note that the C3Deditor is only able to re-read DST formatted files so that exporting 
data to CSV and TXT files is a one-way operation. 

If you require more sophisticated C3D file export facilities then you may wish to 
evaluate another program called RData2 that has been written specifically to export 
binary data from a number of different file formats (including C3D) to DST and user 
customizable ASCII files. 

RData2 is available as a demonstration program from the Motion Lab Systems web 
site on the Internet at http://www.motion-labs.com.

Printing the Data in the File 
The C3Deditor allows you to print the data present in the Analog and 3D channels. 
It allows you to choose the specific channels and also the frames of data that you 
want to print.  Shortcut : CTRL + 

P 

You can use the Print command in the File menu to send data to the printer. This 
command displays a Print Channels dialog box shown in Figure 63 where you can 
select which channels and frames are to be printed. The standard Print dialog box 
then enables you to select a printer. 

The selected data is then printed in tabular form on as many pages as are necessary. 
Each page will be printed with a footer that contains the page number and the 
filename and directory of the source C3D file. 
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Figure 63 – The Print Channels dialog box 

The following steps should be followed, 

1. Choose the Print command (File menu). This opens the Print Channels 
Dialog box. 

2. Choose one or more channels from the Analog Channels box and/or the 
3D Markers box. 

3. The C3Deditor gives you the first and last frame of data collected in the 
First Frame and Last Frame box respectively. Modify these values if 
you want to print a different set of frames. All frames in the range that 
you specify will be printed. 

4. Click OK to print or Cancel to print the operation. 

If you choose OK in the previous step, you will be presented with the Print Dialog 
box. Here you can choose the printer and change the properties. However, you 
cannot choose a range of pages to print nor can you print multiple copies. If you say 
Cancel in this dialog box, the entire operation will be cancelled. 

Exiting the C3Deditor 
The Exit command (File menu) can be used to end your C3Deditor session. You can 
also use the Close command on the C3Deditor Control menu. The program will 
prompt you to save any file that have been modified and have not been previously 
saved. 

Keyboard Shortcut: ALT + 
F4 

 
Figure 64 – You will be prompted if you try to quit without saving your changes. 

Note that this prompt is disabled if you are running the C3Deditor in batch mode. 
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Editing C3D data 

Manually editing the data. 
The C3Deditor provides you with the following editing features: 

• Manually edit any C3D file. 

• Copy and Paste information within the C3D file. 

• Copy data from Excel and import it into the C3D file. 

• Create, delete or edit any C3D item such as groups, parameters and 
their contents. 

• Create, delete or edit frames of data, analog channels and 3D marker 
trajectories. 

• Filter analog and 3D data with high pass, low pass, band pass and band 
stop filters. 

• Interpolate 3D data to fill gaps in marker trajectories. 

It is strongly recommended that novice users make some effort to understand the 
C3D file format before attempting to edit any parameters, groups or other data items 
within a C3D file. Editing, or deleting a parameter can have drastic effects on the 
validity of the contents of the file. 

The C3Deditor has to be in the edit mode before any editing operations can take 
place. 

Edit Mode 
The C3Deditor has to be in the Edit Mode before any of the editing operations that 
will be described in the following sections can be used. The Edit Mode command 
(Edit menu) puts the C3Deditor in the Edit mode. When this is done a check mark 
appears next to this option in the menu and the toolbar button will be set “down”. If 
you are not in Edit Mode then you will not be able to change any of the data in the 
C3D file. 

 The Edit Mode 
toolbar button enables you 
to set the Edit Mode as well 
as displaying the current 
Edit Mode status. 
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"Undoing" operations 
Just in case you make a mistake - any editing or processing operation on a C3D file 
can be reversed by using the Undo command (Edit menu). Only the last operation 
that was performed on the file can be undone.   You can use the 

Undo button to reverse the 
last operation! 

Manual Editing of Data 
It is possible to edit the following items using the C3Deditor, 

• C3D groups and parameters 

• C3D header events 

• Analog Data 

• 3D Data 

It is important to note that LOCKED groups or parameters cannot be edited unless 
the C3Deditor finds that a sub-key named LockedEdit exists with a value "True" in 
the HKEY_LOCAL_MACHINE\Software\MLS\C3Deditor key in the registry.  This 
key has to be added manually if you want to edit the locked groups or parameters. 

Editing or Creating a group 
To edit or create a group in a C3D file follow these steps: 

1. Choose the appropriate group in the Tree in the Main View if you want 
to edit a group or select New - Group from the Edit Menu. 

2. Make sure that you are in the Edit Mode - there should be a check mark 
next to the Edit Mode command (Edit menu). 

3. The group data will be present in the Data box in the Main View. 
Double click inside the box with the Left button and this should open 
the Group Editor dialog box which will allow you to enter the data that 
should be present in the group. 

 

Figure 65 – The Group Editor dialog box 

The group editor dialog box contains the following fields, which display the data, 
and allows you to change it. This dialog box is also opened in response to the New-
Group command (Edit menu) thus much of the following discussion applies to the 
creation of a group. 

Name 
This box holds the name that is used to refer to the group. This name should be 
different from that of all other groups in the file. 

74  •  Editing C3D data The C3Deditor User Guide 



 

Description 
This box holds the description of the group and is used to provide some information 
or a description of the function of the group. This field is often left empty. 

Number 
This box holds the number of the group. This must have a negative value for a group 
and each group must have a unique number. If a group is being created this field will 
be pre-filled with a unique number. Do not create duplicate group numbers. 

Locked 
This is a check box which tells if a group is locked or unlocked. A locked group 
should not be edited although the C3Deditor allows you to do so. It is recommended 
that novice users do not edit or create locked groups. 

OK 
Click on this button to either update the changes made to the selected group or create 
a new group. 

Cancel 
Clicking on this button will cancel any changes that you may have made to the group 
and close the group editor box. 

Help 
Click on this button to display context sensitive help about the group editor. 

Editing a parameter 
To edit or create a parameter, the following steps should be carried out: 

1. Choose the appropriate parameter in the Tree in the Main View or select 
New - Parameter from the Edit Menu. 

2. Make sure that you are in the Edit Mode - there should be a check mark 
next to the Edit Mode command (Edit menu). 

3. The Parameter data will be present in the Data box in the Main View. 
Double click inside the box with the Left button. This will open the 
Parameter Editor dialog box and allow you to enter the parameter data. 

 

Figure 66 – The Parameter Editor dialog box 

The Parameter Editor dialog box is similar to the Group Editor. The following fields 
display any existing parameter data and allow you to change any of the information. 
This dialog box is also opened in response to the New-Parameter command (Edit 
menu). Thus much of the explanations below also apply to the creation of new 
parameters. 
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Name 
This box holds the name of the parameter. The parameter name must be different 
from the names of all other parameters within the same group. Any other parameter 
with the same name must belong to a different group. 

Description 
This box holds an optional description of the parameter. It can be left empty but we 
recommend that it is always used to enter some information that describes the 
parameter and its function. 

Locked 
This is a check box which tells if a parameter is locked or unlocked. The 
C3Deditor may allow you to edit locked parameters if this has been enabled.  By 
default you cannot edit a locked parameter. 

A locked parameter should 
not be edited unless you are 
absolutely certain of the 
effects of editing the 
parameter.  

Group 
This displays the name of the group that “owns” the parameter. If you are creating a 
new parameter, then the first group in the list will be selected for you by default. 

Data Type 
This displays the type of data contained in the parameter. The C3Deditor allows you 
to switch between numeric data types (BYTE, INTEGER and FLOAT) but not 
between the CHAR type and a numeric type. When you switch between the numeric 
types, the parameter data will be converted to the new type. 

Dimensions 
This displays the number of parameter dimensions. If the parameter contains CHAR 
data then the dimensions can vary between 1 to 7, while for the numeric types, the 
dimensions can vary between 0 to 7. Changing the number of dimensions causes the 
number of entries in the Dimension List and the Data box to change appropriately. In 
the case of the CHAR type, the first dimension tells you the number of characters 
that can be present in each data item. 

Dimension List 
This displays the dimensions of the parameter. To edit a dimension value, click on 
the value and edit it. Changing this value will change the number of items in the Data 
box. 

Data 
This displays the actual parameter data and the index where the parameter is 
dimensioned. To edit a data item, click on the value. 

OK 
Click on this button to update the changes or create a new parameter. 

Cancel 
Click on this button to cancel any changes that you may have made. 

Editing an Event 
A C3D file can store up to 18 events in the C3D file header. These are displayed in 
the event data window to the right of the Tree window. This window displays any 
event data present in the C3D file. 
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Figure 67 – The Event data window 

By clicking on the event data window with the mouse you can edit, add and delete 
events 

Each event contains a four character label together with the time in seconds from 
the start of data collection at which the event occurred and the status of the event 
(either ON or OFF). The maximum number of events that can be stored in the C3D 
header is eighteen. If there are fewer events than this, the last entry in this box will 
be Add…. If you double click on this you will be presented with the Event dialog 
box, which enables you to edit and delete the events. 

Double clicking on any 
event in the event data 
windows will select the 
event and open the event 
dialog box to allow you to 
edit the event. 

You can delete an event by selecting it in the event dialog box and then clicking on 
the Delete button. 

 
Figure 68 – The Event dialog box 

The events dialog box has the following fields: 
 
Label 
This is a four-character label that uniquely identifies the event. 
 
Status 
This is the status of the event – either ON or OFF. A check mark in this field implies 
that the event is ON. 
 
Event Time 
The position of the event in the C3D file is stored as the time that the event occurred 
relative to the start of the C3D file. You can choose to manually enter the event time 
by filling in one of the three fields that define the event time. These fields are 
synchronized - any changes in one entry will be immediately reflected in the others. 
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1. Time - this is the time in seconds at which the event occurred from the 
start of data collection. 

2. Video Frame - this is the video frame where the event occurs. This is 
obtained by multiplying the time by the video sampling frequency. 

3. Analog Frame - this is the analog frame where the event occurs. This is 
obtained by multiplying the time by the analog sampling frequency. 

 
Delete 
Clicking on this button will delete the event that you are modifying. This button is 
disabled when you are creating a new event. 

Editing analog and 3D data 
The analog and 3D data in the C3D file can be edited. The C3Deditor allows you to 
edit any frame of data collected.  To edit the data follow these steps: 

1. Choose the appropriate Analog/3D channel in the Tree Window in the 
Main View. 

2. Make sure that you are in the Edit Mode - there should be a check mark 
next to the Edit Mode command (Edit menu) and the edit button should 
be down. 

3. The Analog/3D data will be present in the Data box in the Main View.   
The data in this box can be edited in place.  You just need to double 
click on the value that needs to be edited.  This will open an edit box, 
where you can enter the new value.  When you have done this hit the 
ENTER key or click outside the edit box.  This is very similar to the 
way you rename a file in Windows Explorer. 

You can do this while you are viewing scaled data or unscaled data. It is advisable 
that you do this editing while viewing unscaled data because there will be a change 
in the value actually stored. If you edit scaled data the value that you enter will have 
to be divided by the scale factor and can be stored only as an integer. 

Graphical Editing 
The C3Deditor allows you to edit the data graphically provided that you are not 
viewing the analog sub frames of data (the frames button must be up). 

Double click on the data that you want to change. A vertical dotted line will appear 
at that frame. There will be a small rectangle at the point of intersection of the dotted 
line and the data value at that frame. 

Click inside the small rectangle with the Left mouse button and with the button held 
down, move it up or down the dotted line to change the value. Release the mouse 
button when you have reached the desired position. In case of analog data, the value 
of all the sub frames will also be changed to this new value. 

Copying Items 
You can use the Copy command (Edit menu) to copy the currently selected item. 
This command can be used to copy the selected Group, Parameter or frames of data 
from a document. The selected item can then be pasted into the same file on into 
another open file. 

 Shortcut : CTRL + 
C 

A group or parameter can be copied by selecting it in the Tree control in the Main 
View and then using the keyboard shortcut. 
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You can copy frames of data by either selecting them from the Data box in the Main 
view or from the Graphical view by selecting a range of data frames. If you copy 
analog frames you can only paste them into another analog channel with the same 
Analog to Video ratio. 

 Similarly a frame or frames from a 3D marker channel can only be pasted into 
another 3D marker channel. By selecting the frames from the Main View, you can 
select non-consecutive frames, which cannot be done in the Graphical view. 

Pasting Items 
The Paste command (Edit menu) can be used to paste a group, parameter or frames 
of data that have been placed on the clipboard using the Copy command (Edit menu). 

A group that was previously copied using the Copy command can be pasted into the 
same file or a different file. The Group Editor dialog box will open and show you the 
data that will be pasted. If a group is already present in the file with the same name 
or group number, you will have to enter a different number for the group that you are 
going to paste into the file. The C3Deditor gives you a chance to review the group 
information before the group is pasted into the new file. 

In a similar way, a parameter that was previously copied using the Copy command 
can be pasted into the same file or a different file. The Parameter Editor dialog box 
will open and show you the data that will be pasted. If an identical parameter is 
already present in the target group you will have to change the name of the pasted 
parameter. The C3Deditor gives you a chance to review the parameter information 
before saving it. 

Frames of analog or 3D data that were previously copied can be pasted into another 
channel in the same file or in an open file. The data that will be pasted will overwrite 
the existing data. In the case of Analog data, if you are pasting data from one file to 
another, then the two files must have the same Analog to Video ratio. 

To paste copied data, choose the channel where you want the data pasted and choose 
a frame to which the data should be copied. The same number of frames that you 
copied will be pasted, starting from the frame you choose. You can choose the frame 
from the Data box in the Main view or by double clicking at the desired frame in the 
Graphical view. 

Importing data from Excel 
In many cases you may want to import data from another application that does not 
support the C3D file structure.  This is possible by first reading the non-C3D data 
into Excel from an ASCII file or other data source.  The Excel Import 

Button  

3D data should be read as three columns (X,Y,Z), with each sample on a separate 
row – note that 2D data must also conform to the three column rule so if you’re 
importing 2D data you will need to set one of the axis as all zeros.  Analog data 
should be formatted so that the rows match the 3D samples, additional data samples 
within the 3D sample frame may be stored either in adjacent columns or in the same 
column.  An example Excel spreadsheet (called EXAMPLE.XLS) can be found in 
the C3Deditor demo subdirectory. 

Once your “foreign” data is in the Excel spreadsheet you need to open a C3D file 
to store the data. You can open any C3D file and import the data into it – if you are 
trying to import a foreign format you will need to open a C3D file that has a 
minimum of information – the file dummy.c3d is supplied for this purpose.  You 
should copy this file to a new name and edit the parameters to reflect the foreign 
data environment (if you have to do this a lot then you may want to create a batch 

If you plan to import analog 
data it is most important to 
set the correct Analog and 
Video sample rates before 
importing any data.  Use the 
TOOLS menu to set these 
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values when the empty C3D 
file is first opened. 

file to automate the process).  Check that all the parameters are correct before 
proceeding – as a minimum you will probably want to customize the marker names 
and descriptions.  If you plan to import force plate data then you must enter all the 
force plate information as well as the analog channel names and descriptions. 

Once you have a suitable C3D file open you can import the data into either an 
Analog or Video channel using the Import command (Edit menu): 

• Use the Copy command in Excel to copy the columns of data that need 
to be imported.  If you are importing 3D data, there should be three 
columns of scaled data, one each for the three co-ordinates.  In case of 
Analog data, there should be as many columns as there are analog 
samples per frame of video data. 

• Select the channel from the C3D Structure Tree and then the frame at 
which the data should be inserted in the Data box.  Additional frames 
will be created if necessary.  If the Graph view is the active view when 
the Import command is selected, the data will be inserted from the first 
frame. 

• Choose the Import command to actually import the data.  This 
command is only available if an analog or 3D channel has been 
selected. 

If you are going to import the data using one of the INTEGER formats then you 
may wish to adjust the POINT: SCALE factor.  This is used when data is saved in 
INTEGER format. If you save the data in FLOATING POINT format, then you 
need not change this value, as it will be set to a negative value when the data is 
saved.  This indicates floating-point data. 

If you import data into a 
FLOATING POINT format 
first then the POINT: 
SCALE value will be set 
automatically when the file 
is first saved as an INT file. 

To retain the maximum resolution for integer data, POINT: SCALE should be about 
(max. absolute coordinate value used)/32000. This will allow the coordinates to be 
expressed within the 16-bit integer range. 

Deleting Items 
Any item that is present in the C3D File is capable of being deleted by the 
C3Deditor using the Delete command (Edit menu). 

  Toolbar button 

This command can be used to delete: 

• The selected group or parameter 

• The selected frames of data 

• The selected analog channel or 3D marker trajectory 

The item needs to be selected in the Tree in the Main View before it can be 
deleted. You need to remember that if you delete frames, they are deleted from all 
the Analog and 3D channels.  

This command is enabled 
only if the C3Deditor is in 
the Edit Mode. 

It is important to note that LOCKED groups or parameters cannot be edited unless 
the C3Deditor finds that a sub-key named LockedEdit exists with a value "True" in 
the HKEY_LOCAL_MACHINE\Software\MLS\C3Deditor key in the registry.  This 
key has to be added manually if you want to edit the locked groups or parameters. 

The frames can be selected in two ways – start by viewing an analog or 3D 
trajectory. The two selection methods are: 

1. You can select one or more frames from the Data box in the Main 
View. This can be done using the SHIFT and CTRL keys along with 
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the mouse. The CTRL key with the mouse can be used to select non-
consecutive frames, while the SHIFT key can be used to select 
consecutive frames. 

2. You can also choose a range of frames from the GRAPHICAL VIEW 
by first double clicking on the start of the range and then double 
clicking at the end of the range while holding the CTRL key down. The 
range of the data will be shown by vertical dotted lines. 

The C3Deditor will prompt you before any Delete operation is actually carried out. 
When you are deleting frames of data, the event data present in the file may also be 
affected. If the event happens to be on a deleted frame, the event will be deleted with 
the frame. If not, only the timing of the event will be adjusted. 

Creating a New Group 
The New : Group command (Edit menu) allows you to create a new Group. This 
command opens the Group Editor dialog box, which will allow you to enter the data 
that should be present in the Group. This command is enabled only if the C3Deditor 
is in the Edit Mode. This can be done using the Edit Mode command (Edit menu). 

Creating a New Parameter 
The New : Parameter command (Edit menu) allows you to create a new Parameter. 
This command first opens the Data Type in Parameter dialog , in which you first 
need to tell the C3Deditor what kind of data will be present in the Parameter. 

 

Figure 69 – The Data Type In Parameter dialog box 

The Parameter Editor dialog box is then opened and you can enter the data that 
should be present in the Parameter. This command is enabled only if the C3Deditor 
is in the Edit Mode. This can be done using the Edit Mode command (Edit menu). 

Adding Frames of Data 
The C3Deditor allows you to add frames of data to a C3D file. The frames that you 
select will be added all the Analog and 3D frames, as the C3D file does not allow 
different channels to have different number of frames.  

The timing of the existing 
events in the file are 
adjusted when new frames 
are added. 

In addition to creating the new frames you can specify data values for these frames.  
Thus it is possible to quickly create a C3D file that contains precise 3D positional 
information and analog data. This facility is very useful for creating test files to 
verify software processes that utilize the C3D file structure. 

The command to add new frames to a C3D file is the New: Frames command (Edit 
menu): 
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• The frames can be positioned at any place in the data, but you can only 
add as many frames as are already present in the data file. In other 
words you can at the most, double the number of frames. 

• You can fill the new frames with a different value for X, Y and Z 
coordinates for 3D marker data. 

• You can fill the Analog data with a single value or with a Sine wave or 
Square wave of a specified frequency. 

The New: Frames command opens the Add Frames dialog box. This dialog box 
allows you to select various options when creating the new frames. 

 

Figure 70 – The Add Frames dialog box 

This dialog box contains three sections, one each for the Analog Data, 3D Data and 
point of insertion of the new frames. These sections, and their data options, are 
described below: 

Analog Data 
Fill Type 
This is a box from which you can choose one of the values described below: 

1. Value 
Choosing this means that the frames of data will be filled with a single 
value. This value should be filled into the Min. Value box which will be 
the only box that is not grayed out when you select the single value 
option. 

2. Sine wave 
This will insert a sine wave into the frames of data. You can specify the 
minimum value in the Min. Value box and the maximum value for the 
sine wave in the Max. Value box. This sets the amplitude of the signal. 
The Frequency box determines the frequency of the sine wave. This 
frequency should be entered in Hertz and must have a value less than 
half of the analog sampling frequency to meet Nyquist criteria. 

3. Square wave 
This will insert a square wave into the data. Like the sine wave, you 
can specify the minimum value in the Min. Value box and the maximum 
value in the Max. Value box to determine the signal amplitude. The 
period of the square wave should be entered in the Frequency box. This 
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should be entered in Hertz and must have a value less than half of the 
analog sampling frequency. 

3D Data 
This section enables you to create 3D marker data by specifying the values to be 
filled into the X, Y and Z coordinates of the data in the Value X, Value Y and Value Z 
boxes respectively. 

Insert At 
This allows you to choose where the new frames should be inserted. You can do this 
by choosing one of the following values from the Drop down box. 

1. Start of Data - this allows the frames to be inserted prior to the start of 
the existing data. 

2. End of Data - this allows the frames to be appended to the end of the 
existing data. 

The After Frame box will be enabled only if you choose the After Frame option. 
This allows you to select a point within the file at which the data will be inserted. 

• After Frame - this selection allows you choose a frame after which the new 
frames will be appended. If you select this option you need to enter a value for 
the frame in the After Frame box. This can be anything between the first frame 
and one less than the last frame. The C3Deditor shows you the first and last 
frame in the file in this dialog box to help you. 

• Frames - you have to select the number of frames that need to be inserted. This 
can be any value greater than zero but must be less than the number of existing 
frames. 

Creating a new Event 
The C3Deditor allows you to create events in the C3D file. The menu command for 
this is the New: Event command (Edit menu). 

For this command to be active, you must select a frame of data at which the event 
will be created.  This can be done by selecting a frame in the data box in the main 
view or by double clicking inside the graph in the graph view to select a location. 

This command opens the Event dialog box (See Page Error! Bookmark not 
defined.) where the data can be entered. 

Creating a new Analog Channel 
The C3Deditor allows you to create analog channels in the C3D file. The menu 
command for this is the New : Analog Channels command (Edit menu).  
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Figure 71 – The Add Analog Channel dialog box 

This command opens the Add Analog dialog box, in which you can define the 
parameters associated with, and that define, the channel to be created. You can: 

• Fill the Analog channel with a single value, a square wave or a sine 
wave of desired amplitude and frequency. 

• Set the parameters that belong to this channel. 

The new channel that is created is inserted at the location of the analog channel 
selected in the tree.  If no analog channel is selected, it is appended at the end of the 
already existing channels. The dialog box has the following fields, 

Fill Type 
This enables you to define the contents of the new channel for a number of 
possibilities: 

1. Value – Set a single value for every frame of data in the channel. The 
value will be entered in the Min Value box. 

2. Sine wave – create a sine wave in the new channel. You can control the 
amplitude of the sine wave by entering the range in the max and min 
values boxes. The frequency box sets the frequency, which should be 
entered in Hertz. It must have a value less than half of the Analog 
sampling frequency. 

3. Square wave – create a square wave in the new channel. The 
amplitude is set by the max and min values which are entered in integer 
units. The period the square wave is set by the entry in the Frequency 
box, which is entered in Hertz and must have a value less than half of 
the Analog sampling frequency. 

Name 
This is the name that will be assigned to the new channel label. 

Description 
This is a description that will be assigned to the new channel. Try and use this box to 
enter some useful information about the channel or the data. 

Units 
This is a unit of the data in the new channel (V, mV, Nt. etc). 

Scale 
This is the Scale factor that will be applied to the data in the new channel. 

Offset 
This is the value that will be subtracted from the raw data before the Scale factors are 
applied – normally this value is 2048. 
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Creating a new 3D Marker 
The C3Deditor allows you to create a new 3D Marker. The menu command for this 
is the New: 3D Marker command (Edit menu). 

 
Figure 72 – The Add 3D Marker dialog box 

This command opens the Add 3D Marker dialog box, in which you can choose the 
manner in which this channel will be created. You can: 

• Fill the 3D Marker with a different value for each coordinate. 

• Enter parameters that define this marker or trajectory. 

The new marker that is created is inserted at the location of the marker selected in 
the tree.  If no marker is selected, it is appended at the end of the already existing 
markers. The dialog box has the following fields, 

Fill Type 
The two options here are “value (scaled)” and "value (un scaled) to allow you to 
specify the X, Y and Z coordinates. 

1. X Cord - this is the value of the X Coordinate. 

2. Y Cord - this is the value of the Y Coordinate. 

3. Z Cord - this is the value of the Z Coordinate. 

Name 
This is the name that will be assigned to the new marker label – normally a four-
character label. 

Description 
This is the description for the new marker – it’s a good idea to try and enter some 
information here that will tell you the function or purpose of the new point that you 
have created. 

OK 
Click on this button to create the new marker and fill it with appropriate data. This 
will also update the relevant parameters. 

Cancel 
This button will cancel the entire operation without saving any new marker 
information. 

Help 
Clicking on this button will take you to the C3Deditor context sensitive help where 
you can get instant information about any of the commands and functions at the 
touch of a button. 
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Processing Data 

Processing data in the C3D file. 
This chapter looks at the various processing methods that are available through the 
C3Deditor. The C3Deditor allows you to perform the following processes on the 
C3D file. 

You must be in Edit mode to change any data in a C3D file - When the Edit button 
is down, you can change data within the file as well as append and merge data to 
the file.  The ability to change the file is disabled when the Edit button is up.  Click on the Edit 

button in the toolbar to 
change the Edit mode. 

Append Data 
You can add frames to the start or end of a data file from another C3D file if it 
contains the same number of analog and 3D channels. 

Merge Data 
You can add one or more analog and/or 3D markers to the existing data file from 
another data file. 

Sampling Frequency Change 
You can change both the Video sampling rate and the Analog to Video ratio by re-
sampling the original data. 

Interpolation 
You can interpolate the 3D data to fill gaps based on gap length or residual values. 

Delete and Fill 
You can delete a range of 3D data frames and automatically interpolate the gap – this 
is very useful for removing small spikes or discontinuities from a trajectory. 

Filter data 
The C3Deditor provides full control over a Finite Impulse Response (FIR) filter that 
can be applied to both analog and 3D data in a C3D file. 

Validity Checks 
You can automatically check the validity of parameters, analog data and 3D data 
within a C3D file to ensure that a file contains valid information. 

In addition, all of these commands can be run automatically from a batch file when 
any C3D file is opened so that many common operations can be automated – such as 
adding a special set of parameters to every C3D file for automatic processing by 
MOVE3D and other programs. 
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Appending data from another file 
The C3Deditor allows you to append frames from a data file into the open file. This 
addition of frames can be done at the start or end of the open file. There are a few 
conditions that need to be met by the two files for this operation to be successful. 
They are: 

1. Number of Analog channels collected should be the same. 

2. Number of Video markers collected should be the same. 

3. The Analog to Video Ratio should be the same. 

4. The storage format of the data should be the same, i.e. INTEGER or 
FLOATING POINT. 

5. The sampling frequency should be the same. 

6. The C3Deditor must be in Edit mode. 

If the above conditions are satisfied, you can perform the Append operation by 
choosing the Append command (Tools menu). This opens the Append dialog box. 

 

Figure 73 – The Append File dialog box 

This dialog box contains the following fields: 

Select File 
This displays the standard Windows File Open dialog so that you can select the C3D 
file that contains the information that you want to append to this file. When you have 
selected a file, the Append File Information section will contain information about the 
file. 

First Frame 
This is the first frame of data from the selected file that will be added to the current 
file. The C3Deditor will check that the value you enter is valid for the range of 
frames reported in the Append File Information box. 

Last Frame 
This is the last frame of data from the selected file that will be added to the open file. 
The value you enter here must be within the range of frames reported in the Append 
File Information box. 

Append At 
This determines if the data is added to the Start of the file or at the End of the file. 

Conditions 
This displays some information to help you determine if the append operation can be 
carried out successfully – if you are having problems appending files together then 
this may help you correct the problems. 
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The append operation takes the selected frames of data and adds them to the start or 
end of the current C3D file. This will not change the value of the First Frame of 
Data that is found in the C3D file header. The append operation only adjusts the 
value of the Last Frame in the Header section. 

When you append data to 
the start of the file, the event 
times in the existing file will 
be adjusted. 

Merging Data 
The C3Deditor allows you to import data from another C3D file and merge it into an 
existing C3D file. This operation adds these new analog or 3D channels to the end 
of the present data. The two sets of data do not have to have the same number of 
frames, as the C3Deditor will always create a new file with the larger of the data 
sets. Any empty frames will be filled with a zero value. 

The merge feature can be 
used to record several 
different subjects within the 
same calibration volume in 
separate trials. These trials 
can then all be merged 
together to create a single 
C3D file that contains 
several sets of subjects 
moving through the same 
volume. 

 
Figure 74 – The Merge File dialog box 

There are certain conditions to be met by the two files that you want to merge – these 
are: 

1. The Analog to Video Frames Ratio should be the same in both C3D 
files. 

2. The storage format of the data should be the same in both C3D files 
(i.e. Floating Point or integer) 

3. The video sampling frequency should be the same. 

4. The C3Deditor must be in Edit mode. 

If the above conditions are satisfied, you can perform the Merge operation by 
choosing the Merge command (Tools menu). This opens the Merge dialog box, which 
contains the following fields: 
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Select File 
This opens a standard File Open dialog box that you use to select the file that you 
want to merge into the current file. The full path and filename will be displayed once 
you have selected a file. 

Analog Channels 
This displays the names of any analog channels in the input file and allows you to 
select the channels to merge into the document. You can use the SHIFT and CTRL 
keys to make multiple selections. 

3D Marker Channels 
This displays the names of the 3D channels in the input file and allows you to select 
the markers to merge into the current C3D file. Use the mouse with the SHIFT and 
CTRL keys to make multiple selections. 

OK 
Click on this button to validate the changes made and to start the Merge operation 
provided the required conditions are met. 

Conditions 
This provides some information about the conditions that must be met for the merge 
operation to be carried out successfully. 

In merging the two files together, the C3Deditor takes the selected channels and adds 
them to each frame of data. The total number of data frames in the new file will then 
be the greater of the frames in the two data files. The frames for which there is no 
data will be set to zero. 

The ANALOG parameters LABELS, DESCRIPTION, SCALE, OFFSET, UNITS 
and the POINT parameters LABELS and DESCRIPTIONS of the document will be 
modified. The labels corresponding to the channels that were added will be added at 
the appropriate place in the parameter section. Thus there could be duplicate channel 
names if the two files contain similar labels. 

Sampling Frequency 
The analog and 3D data often have different sampling frequencies. This is allowed 
because the analog sampling frequency is the product of the video sampling 
frequency and the Analog to Video ratio.  When in Edit mode the C3Deditor allows 
you to change both the Analog to Video ratio and the video sampling frequency 
(which will also affect the analog sampling frequency) independently as described in 
the sections below. 

Changing the Sampling Frequency 
In this section, we will see how to change the video sampling frequency, which will 
also change the analog sampling frequency. This is done with the Sampling 
Frequency command (Tools menu). This command opens the Sampling Frequency 
dialog box, which displays the existing Sampling Frequency and allows you to enter 
a new value. The number of frames of data increases or decreases depending on the 
new frequency. 

The sampling frequency 
value must always be 
greater than zero. 
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Figure 75 - The Video Sampling Frequency can be easily changed. 

This dialog box is used to change both the Video Sample Rate as well as the Analog 
to Video ratio as described in the next section. The dialog box contains a single box: 

Sampling Frequency - this will initially display the current sampling frequency in 
Hertz – enter the new value (which must be greater than zero). 

• Decreasing the sample frequency is implemented by picking the correct 
samples and then carrying out a linear interpolation if the point is 
between two original data values. 

• Increasing the sample frequency is accomplished by linear 
interpolation. 

When new data values are created for 3D information the residual will be set to 0 
since the co-ordinates of the data have been calculated and not measured. 

Changing the Analog to Video ratio 
The analog to video ratio can be changed independently of the sampling frequency 
via the Analog to Video Ratio command (Tools menu) command. This opens the 
Sampling Frequency dialog box, which displays the present value of the Analog to 
Video ratio and allows you to enter a new value that is greater than zero. The number 
of samples of analog data per 3D sample (or video frame) increases or decreases 
depending on the new sampling frequency chosen. 

Both these processes use a linear interpolation to generate the new analog data 
points for all the analog channels. This is essential as the analog bandwidth of the 
channels changes when the number of samples for each channel is either 
increased or decreased.  Increasing the sample rate does not have any filtering 
effect of the sampled data or add additional frequency components that were not 
present in the original data.  However, decreasing the analog sample rate has the 
effect of applying a Low Pass Filter to the analog data – the new analog data will 
be effectively filtered at a frequency of half the new sampling frequency.  This 
effect is permanent – the missing frequencies will not be restored to the signal if 
the analog sample rate is subsequently raised. 

Decreasing the Analog 
Sample Rate will apply a 
filter to the analog data. 
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Figure 76 – The Analog Sampling Frequency dialog box. 

• Lowering the sample rate is accomplished by picking the correct 
samples and then carrying out a linear interpolation if the point is 
between two original data values. 

• Increasing the sample rate is accomplished by linear interpolation. 

The sampling frequency of the 3D data will not be changed as result of this 
operation.  

Interpolation 
The C3Deditor allows you to interpolate 3D data. The command that needs to be 
used is the Interpolate command (Tools menu). This command opens the Interpolate 
Dialog box, which allows you to choose the options for Interpolation. 

This command is only 
available if a 3D marker 
has been chosen in the Tree 
control in the Main View. 

 
Figure 77 – The Interpolate 3D data dialog box 

The interpolation dialog box has the following fields that control the manner by 
which frames are chosen for Interpolation. 

3D interpolation is done 
using the Cubic Spline 
method. 

Fill Gaps Less than – select this to fill gaps in the 3D data. Enter the size of the gap 
in frames - you can enter any value greater than zero but remember that filling very 
large gaps may result in unpredictable results. If the C3D trajectory contains gaps 
less than the value that you select, then a cubic spline interpolation is used to 
generate information to fill the gap. 

The C3Deditor will not interpolate data in the gap if it is present at the start or end of 
the data collection - this would be “extrapolation”. To get around this you can 
manually set the first (or last) frame to some appropriate value and then allow the 
C3Deditor to Interpolate. 
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Interpolate if Residual Greater than – this performs interpolation for any 3D 
sample that has a higher residual than the specified value. You can enter any value 
greater than zero – usually a value of 2.5 is a good default. This method recalculates 
the values of frames where the residual is greater than the value that you specify. The 
C3Deditor assumes that data was not collected at these frames and uses the other 
frames to compute the data. 

Interpolate All Channels – select this box to interpolate the data in all the 3D 
channels. If this box is left unchecked, only the data in the selected channel will be 
interpolated. 

After the interpolation is complete, the residual and camera mask value for each 
marker for the computed frames is set to 0. 

Delete and Fill 
This is a quick and easy method to select a range of data, delete the range and refill 
the range by interpolation – it is very convenient for removing isolated spikes in the 
data. The command is Delete and Fill (Tools menu). 

To use “delete and fill” follow these steps: 

1. Select a 3D channel from the Tree control in the Main View. 

2. Select the range of frames from the Graphical View. One end of the 
range can be selected by double clicking on the desired frame. The 
other end can be selected by double clicking with the CTRL key 
pressed. 

3. Select the Delete and Fill command from the Tools menu. 

Caution should be exercised in the use of this command because deleting a large 
number of frames will mean that the C3Deditor will not be able to recreate an 
accurate picture of the old data. 

After this operation is complete, the fourth data value for each marker for the 
computed frames is set to 0. 

Filtering Data 
The C3Deditor allows you to filter both analog and 3D data using different menu 
commands. The current filters available are the Finite Impulse Response filter (called 
a FIR filter) and the Butterworth filter. 

The FIR filter is a digital filter and allows the C3Deditor to provide high pass, low 
pass, band pass and band stop filtering for both analog and 3D trajectory data. A full 
technical discussion of the implementation of the FIR filter in the C3Deditor follows 
– if you just want to smooth the data then you may wish to skip the next two pages… 

FIR Filters 
A FIR filter is one whose input-output relationship is described by, 

∑
=

−=
L

n
nknk xby

0

 

The related transfer function can therefore be written as, 

∑
=

−−− =+++==
L

n

n
n

L
L zhzbzbbzBzH

0

1
10 ...)()(  

The C3Deditor User Guide Processing Data  •  93 



 

where hn defines the impulse response of the filter. This indicates that a FIR may be 
designed by specifying the finite sequence hn. 

Two constraints have been imposed on the design procedure used for the filter 
realizability (or causality) and a linear phase response. The first condition implies 
that the impulse response is zero for k<0. The transfer function given above satisfies 
this condition. The second condition of linear phase is a desirable condition for any 
filter. In terms of the transfer function this implies that H(z)=H(z-1). A FIR filter 
trying to achieve a linear phase response would have poles outside the unit circle and 
hence the resulting filter would be unstable. Since zeros outside the unit circle do not 
affect stability, the required condition can be satisfied in the FIR case by requiring 
zeros to exist in mirror image pairs, for example z1, 1/z1, inside and outside the unit 
circle. 

In FIR filter design, an equivalent condition for linear phase response is symmetry in 
the coefficients such that, 

)2int(0 Ln ≤≤nLn bb −=                         

If L is even, the total number of coefficients, which is by definition the length of the 
filter, L+1, is odd. In this case there is a central sample bL/2 about which the 
coefficients are symmetric. If L is odd, the upper limit on n in the above equation is 
actually (L-1)/2 and there is no central sample corresponding to the midpoint of the 
filter. The condition imposed by this equation, results in a fixed delay of (L/2)T 
seconds, where T is the sample interval. The corresponding phase response is given 
by θ(ω) = -ω(L/2), where ω is the normalized frequency in radians. 

The ideal low pass filter can be expressed in terms of the Fourier transform as, 
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where ωc defines the normalized filter cutoff frequency in radians and L/2 
corresponds to the delay required to satisfy the causality constraint. 

The ideal impulse response hd(n) which corresponds to the filter specified by the 
above equation is obtained by evaluating the inverse Fourier transform 
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The impulse response in the equation above is an infinitely long sequence. To 
accomplish FIR filter design, the response is truncated and defined as, 

Ln ≤≤0(n)h(n)hd =                      

0=                                       elsewhere 

Since the infinitely long sequence shown above is approximated by the truncated 
sequence, the abrupt truncation of the long sequence results in an oscillatory effect 
known as Gibbs phenomenon. The maximum magnitude of the oscillation is 
relatively constant regardless of the order of the filter. 
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Increasing the length of the filter has four primary effects, 

• Reduction in the width of the transition band. 

• Increase in the frequency of the oscillatory response. 

• Increased delay. 

• Increased computational burden in the filter implementation. 

Since the Gibbs oscillations result from the abrupt truncation of the infinite series, 
window functions can be used to truncate the infinitely long sequence. The 
Hamming data window has been used to truncate the sequence. This window has a 
narrow main lobe since this affects the width of the transition band of the frequency 
and side lobes that rapidly decrease in energy for increasing ω, since this results in 
smaller ripples in both the pass band and stop band of the filter. 

Applying the window results in lower side lobe levels. However the price paid is an 
increase in the width of the main lobe. This translates directly to an increase in the 
transition bandwidth of the filter response.  

Using the Filter 
The C3Deditor allows you to filter both analog and 3D data independently. The 
commands used are: 

• Filter Analog command (Tools menu). This command is available only 
when the Analog Data item or its sub item is chosen in the Tree in the 
Main View. 

• Filter 3D command (Tools menu). This command is available only 
when the 3D Data item or its sub item is chosen in the Tree in the Main 
View. 

If you are going to filter only selected frames of data then the selection can be made 
in either the Main View or the Graphical View before the filter command in 
selected: 

You need to make sure that 
the Active View is the same 
view in which you have 
made the frame selection – 
check this by looking at the 
Status bar. 

• In the Main View, you select a range of frames the Data box. 

• In the Graphical view, you select the range of frames, by double 
clicking at the start of the range and double clicking with the CTRL key 
pressed at the end of the range. 

If you do not select a range of frames then you will be prompted for the start and end 
of data in the filter dialog box. 

When the Filter Dialog box opens it will display the options that you had used 
previously. If you had a channel selected when you chose this command, this will be 
the channel that will be filtered. You will of course be given the option to select 
more channels. You need to make the following choices in the Filter Dialog box: 

1. The channels or marker trajectories to be filtered. 

2. Type of Filter used (FIR is the default) 

3. Type of Filtering to be carried out (LPF, HPF, BPF etc.) 

4. Order of the Filter (20 is the default) 

5. Selection of Frames to be filtered. 

The C3Deditor User Guide Processing Data  •  95 



 

6. Cut Off Frequencies. 

Note that the commands to change the Analog and Video Sampling Frequencies can 
also have the effect of Low Pass filtering the data when the sample rate is decreased 
by virtue of lowering the Nyquist Frequency of the data.  Changing the data 
sampling frequency causes the data to be linearly interpolated to generate new data 
points – this is not the same process as used in the Filter Command. 

If you have large numbers of files that require filtering, or regularly apply the same 
set of filters to your data, then you may wish to create a batch file that defines the 
signal filtering.  This batch filtering can then be automatically applied to each file as 
it is opened – thus saving a considerable amount of time and ensuring that each data 
file is filtered in exactly the same way. 

Filter Dialog box 
This dialog box allows you to set the options of the Filter that will be used to Filter 
the data. The default values can be set by using the Options command (Tools menu). 

 

Figure 78 – The Filter dialog box 

The following fields are available in the dialog box: 

Filter  
This will allow additional filter types to be implemented in future versions of the 
C3Deditor. The available filters are the FIR filter and the Butterworth filter. 

Order  
This is a slider control, which allows you to set the order of the filter – the default 
value for this item is 20. 

Type 
This allows you to select the type of filtering that should be carried out. The four 
types possible are, 

1. LPF - Low Pass Filter 

2. HPF - High Pass Filter 

3. BPF - Band Pass Filter 

4. BSF - Band Stop Filter 
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Frame Selection 
This allows you to select the frames that will be filtered from each channel. There 
are three ways in which this can be done, 

1. All - this selects all the frames in the selected channel(s) for 
filtering. This is the common option. 

2. Selection - this sets a range of frames for filtering. The start and 
end of this range can be specified in the Start Frame and End 
Frame boxes respectively which appear if this option is chosen. 

3. Residual - this option is only available if you are filtering 3D 
marker data. This selects only those frames with a residual value 
above that specified in the Residual Threshold box to be filtered. 
The residual threshold box is visible only when this option is 
chosen. 

Channels 
This allows you to choose one or more channels to be filtered. 

Lower Cut Off Frequency 
This is the lower cut off frequency. For LPF and HPF this is the only frequency 
required. 

Higher Cut Off Frequency  
This is the upper cut off frequency. For LPF and HPF this field is hidden. 

Note that you must select reasonable values for the low and high band entries. The 
highest frequency present in the input data is controlled by the sample rate, which is 
displayed in the filter dialog box above these two boxes. 

Removing baseline drift from force plate channels 
The command Zero FP Channels can be used to remove the baseline drift the might 
creep into the force plate channels. 

This is done by averaging the data found in the channel over a number of frames 
found in the FORCE_PLATFORM: ZERO parameter.  The data in the channel is 
then adjusted so that the offset at the beginning is 2048. 

For this command to work the following parameters need to be present: 

• FORCE_PLATFORM:USED 

• FORCE_PLATFORM:TYPE 

• FORCE_PLATFORM:CHANNEL 

• FORCE_PLATFORM:ZERO 

This command opens the Force Plates dialog box shown in Figure 79 from which 
you can choose the force plates to which this process should be applied. 
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Figure 79 - Force Plates dialog box 

Validating data in the C3Deditor 
The C3Deditor allows you to validate the parameters, analog data and the 3D data in 
the C3Deditor. Each of these three operations has different menu commands as 
explained in the following sections.  The validate feature is very useful when you are 
presented with a C3D file that cannot be read by a third-party application.  The 
Validate feature will can be used to test the C3D file against a known set of 
parameters and data values. 

Validating Parameters 
The Validity : Parameter command (Tools menu) can be used to check the validity of 
the parameter data. This command checks the following, 

• The group that the parameter belongs to. 

• The Data Type of the parameter. 

• The number of dimensions of the parameter. 

• The values of the Dimensions of the parameter. 

The C3Deditor reads the values from the validity file, which contains these values 
for the data collected in your laboratory. It then compares this with the Parameters 
found in the data file. It reports its finding in the Validity Results Dialog box in text 
form. 

This can be a powerful tool 
to validate the contents of 
C3D files produced in your 
own motion lab as well as 
allowing a user to scan C3D 
data files that may be sent 
from other facilities. 

Validating Analog Data 
The Validity: Analog Data command (Tools menu) can be used to check the validity 
of the parameters, which are related to the Analog data. It makes sure that the values 
in the ANALOG parameters are valid in the following way: 

• LABELS – checks that the number of labels exceeds or is equal to the 
number of Analog Channels collected and the data type is CHAR. 

• GEN_SCALE – checks that data is actually present in this parameter 
and it is a FLOATING POINT data type. 
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• SCALE – checks that there are at least as many data items as there are 
channels and that the data type is FLOATING POINT. 

• OFFSET – checks that there are at least as many data items as there are 
channels and that the data type is INTEGER. 

• UNITS – checks that there are units present for each of the channels 
collected. 

• USED – checks that the number of analog data channels in the C3D file 
agrees with the value found in this parameter. 

• RATE – checks that the Sampling Rate of the data matches the rate 
stated in this parameter. 

The C3Deditor reports the finding in the Validity Results Dialog box. There is a list of 
entries in that box which states the findings of this operation. 

Validating 3D Data 
The Validity: 3D Data command (Tools menu) can be used to check the validity of the 
3D data. This command checks the following: 

• Checks that the data contained in each channel is within the bounds as 
specified in POINT: DATA_LIMITS. This is an excellent test for data 
corruption within a C3D file. 

• Checks that the values in the POINT parameters LABELS, USED, 
SCALE, RATE, DATA_START, and FRAMES are consistent with the 
data. 

The C3Deditor reports the finding in the Validity Results Dialog box. 

This command cannot be executed unless the parameters POINT: DATA_LIMITS, 
POINT: SCALE are found. 

Configuration 
The C3D validity checks are controlled by a text file that is defined in the Tools 
Menu. This file defines the base characteristics of the data files and will need to be 
edited to conform to the parameter and data specifications of your environment 
before any validity checks can be performed.
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C3Deditor Options 

The C3Deditor is controlled by a number of options that define how it functions and 
presents the data. All these options are available through selecting a single 
command, namely Options command (Tools menu). This opens the Options dialog 
box which is a tabbed dialog box containing three pages as described in the sections 
below. 

These options can only be 
changed from the Tools 
menu when a C3D file is 
open.  If you do not have an 
open C3D file you can 
access the options from the 
File menu. 

General Page 
This page has options that are useful in the general running of the C3Deditor. These 
will be set to the demo values when the application is installed - you may want to 
change these when you start using the editor. 

 

Figure 80 – The General Options page 

The General Page contains the following fields that can be set using the browse 
buttons to select specific files: 
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• Parameter Validity File - this allows you to select the file that is used 
to check the validity of the Parameters in the file. 

• Batch File - this allows you to set a file that contains commands that 
will be executed whenever a C3D file is opened in Batch processing 
mode. 

• Printing Font - this field shows you the Font name, font size and 
Italic/Bold selection of the typeface used for printing. You can change 
these attributes for the font by clicking on the Font button next to this 
field. 

Any changes made to the General Page options will not take effect until the 
C3Deditor is restarted. 

Views Page 
The Views Page contains the options that define the way you view the data. 

 

Figure 81 – The Views Options page 

This is the only page in which the Apply button is enabled when you make any 
changes in the page. If you click on this button, the changes are applied to all the 
open files immediately. The Views Page has the following options: 

• Scale Analog Data – select this to display the Analog data as scaled 
values by default. 

• Scale 3D Data – select this to display the 3D data as scaled values by 
default. 

• Show Analog Sub Frames – select this to display every analog 
sample. If this is not selected then only a single analog sample will be 
displayed for each 3D frame. Unlike many other programs, the 
C3Deditor allows you to view every analog sample to get a better idea 
of the quality of the analog data. 
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• Show Data in list – this option can be used to disable the data display 
in the lower left numeric display. 

• Flag residuals above this value as high … The data displayed in the 
Graphical view for 3D data will be in the chosen color if the residual 
for that frame is greater than the value you enter in this field. This is a 
very convenient way of judging the quality of the 3D data. 

You can also choose the default size of the Analog and 3D plots. There are four 
fields to do this: 

• Analog Data: Vertical Size. This sets the vertical size of the Analog plots. 
Enter values in inches. 

• Analog Data: Distance between frames – This sets the horizontal distance 
between frames of the Analog plots. Enter values in between 1 and 5 where 
each unit is 0.01 inch. 

• 3D Data: Vertical Size – This sets the vertical size of the 3D plots. Enter 
values in inches. 

• 3D Data: Distance between frames – This sets the horizontal distance 
between frames of the 3D plots. Enter values in between 1 and 5 where each 
unit is 0.01 inch. 

• Choose distance between Frames to fit Screen - Sometimes the data will 
contain very few frames. If this is the case then the default horizontal scale 
might be too small. Set this option to allow the C3Deditor to adjust the 
horizontal scaling in order to fit the data to the screen. It is recommended 
that you leave this option turned ON. 

• You can also choose the colors that the application should use for certain 
things.  There are three buttons that help you do this: 

• High Residual Color - This is the color to be used to draw the point if the 
residual value is above the limit specified in the Flag Residuals above this 
value as High box. 

• Zero Residual Color - This is the color to be used for the point if the 
residual value is zero. 

• Event Line Color - This is the color to be used for event lines. 

 

Interpolate Page 
This property page controls the default interpolation options that will be used 
whenever a 3D channel or trajectory is interpolated. 
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Figure 82 – The Interpolate Options page 

The interpolation page has the following options: 

Interpolation Type 
This allows you to select the default rules that determine when the 3D data is 
interpolated. You can choose one of the two values: 

1. Fill Gaps – selecting this option will cause any gaps in the 3D data that 
are less than the specified value to be filled. 

2. Residual Threshold – selecting this option will apply a function that 
will delete 3D samples with a residual greater than the specified value 
and interpolate the resulting gap. 

Gaps 
Enter the number of frames that you consider constitute a gap. You can enter any 
value greater than zero but it is not a good idea to try and interpolate very large gaps 
automatically – 10 is a good default for the gap value. 

Residual 
Enter the maximum residual value in this option to cause the residual based 
interpolation to delete and fill any points that have larger residuals. You can enter 
any value greater than zero. Residuals in the range of 2.0 to 2.5 are good default 
values. 

Interpolate All Channels 
Use this box to default the C3Deditor to interpolating every 3D channel present in 
the C3D file. If this box is left unchecked, only the data in the selected channel will 
be interpolated by default. 
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C3Deditor Files 

Batch File Format 
The C3Deditor uses the Batch file when it is in the batch mode to 
process a set of instructions. This file is made up of sections. There is 
only one compulsory section. The other sections depend on the first 
section.  

A full installation of the 
C3Deditor will copy more 
than 20 sample batch files 
to your system. 

The application can be started in the batch mode by using the -b switch. 

The compulsory section is shown below: 
 
[General] 
File=BATCH FILE 
Save=TRUE,{INTEGER|REAL},{PC|DEC|SUN} 
AnalogOffset=2047 
Exit=TRUE 
Operations=6 

This section is always found at the start of every batch file. 

[General] is the name of the section. Do not change this as the C3Deditor uses this 
item. 

File=BATCH FILE is a check for the C3Deditor . Do not change this as the C3Deditor 
uses this to check that it has opened the correct file. 

AnalogOffset=VALUE allows you to set the value of the Analog:Offset Parameter to 
the value specified by VALUE. 

Save=TRUE|FALSE, {INTEGER|REAL}, {PC|DEC|SUN} If set TRUE then the C3D file 
will be automatically saved when the batch operation has completed. The file will 
not be saved if this is FALSE. If the file is saved then the additional parameters 
control the format used to save the file. If they are not specified then the file will be 
saved in the existing format. 

Exit=TRUE|FALSE If set TRUE then the application will exit if the application was 
opened with a file and also was opened in the batch mode.  This does not come into 
play if you open a file from within the application using the File : Open command. 

Operations=6 This is the number of operations, defined in the CFG file, that will be 
read and performed. Each section specifies one operation to be performed. Each 
section is performed in sequence on the file.  You can have more operations defined 
in a CFG file than are actually used – if you define 10 separate operations but only 
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set Operations=8 at the head of the CFG file then only the first eight operations will 
be performed. 

Each succeeding section is named [OperationN] where N is a number between 1 and 
999. Each operation can perform a single edit function. 

Add an Analog channel 
This allows you to add an analog channel at a particular location in the file. 

To add an analog channel 
[Operation1] 
Type=Analog 
Command=Create 
Name=MLS 
Description=MLS Example Channel 
Units=V 
Scale=1 
Offset=2048 
InsertAt=3 
FillType=Sine 
Value=2400,2200,200  

Type = Analog specifies that an analog channel will be acted upon 

Command=Create tells the application to create an analog channel 

Name=MLS 

This is the name that will be given to the channel.  This is an essential line. 

Description=MLS Channel 

This is the description that will be given to the channel.  This defaults to Desc. 

Units=V 

This is the unit that will be used for that channel.  This defaults to V. 

Scale=1.0 

This is the scale to be applied to the channel.  Defaults to 1. 

Offset =2048 

This is the offset to be applied to the channel.  Defaults to 2048. 

InsertAt=3 

This is the location in the list of analog channels at which the channel will be 
inserted.  If this line is not present the channel will be inserted at the end. 

FillType=Sine|Square|Value 

This is the type of data will be used to fill the channel with.  If this line is not present 
a single value will be used to fill the analog channel. 

Value=Max,Min,Frequency 

If a single value is being used, only the first value is necessary.  If sine or square fills 
are being used, all three values should be present. 

Delete an Analog channel 
This allows you to delete an analog channel. 
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To delete an analog channel 
Type=Analog 
Command=Delete 
Channel=3 

Type= Analog specify that an analog channel will be acted upon 

Command=Delete tells the application to delete a channel. 

Channel=N 

This is a 1-based number of the channel to be deleted. 

Filter Analog Data 
This filters the analog data in the C3D file using the same functions as the manual 
analog filter. 

To Filter All Analog Data 
 
[OperationN] 
Type=FilterAnalog 
Command=FIR,LPF,100,0,21,All 
Channels = 4,5,6-10 

To Filter Selected frames of Analog data 
 
[OperationN] 
Type=FilterAnalog 
Command=FIR,LPF,100,0,21,Selection 
Frames=80,100 
Channels = 4,5,6-10 

Type=FilterAnalog specified that an analog filter operation will be performed. 

Command = Filter, Type, Low Freq, High Freq, Order, Data is the filter control line 
where: 

Filter is the name of the filter - this can be set to FIR or Butterworth for the current 
version of the C3Deditor. 

Type is the class of filtering desired which must be set to LPF, HPF, BPF or BSF 
(Low Pass, High Pass, Band Pass, and Band Stop). 

Low Freq is the lower band frequency. 

High Freq is the upper band frequency. 

Order is the Order of the filter. 

Data determines if we are filtering all of the frames or a range. 

Frames = StartFrame, EndFrame is only required if the Data field above is Selection. 
This allows you to define a range of frames to be filtered. Start Frame is the frame 
from which filtering will start while End Frame is the frame at which filtering will 
end. 

Channels is needed if you want to filter specific channels. You should separate 
individual channel numbers with commas or use a range (e.g. 1-10) to filter range of 
channels. If this line is missing then all channels will be filtered. Use this line to set 
up separate filters for EMG, Force and other analog inputs as separate filter 
command operations. 
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Add a 3D Marker 
This allows you to add a 3D marker at a particular location in the file. 

To add a 3D marker 
Type=Video 
Command=Create 
Name=Vid 
Description=Video Channel 
ValueX=200 
ValueY=500 
ValueZ=400 
ValueType=Scaled 
InsertAt=3 

Type= Video specify that a 3d marker will be acted upon 

Command=Create tells the application to create a marker 

Name=Vid 
This is the name that will be given to the marker.  This is an essential line. 

Description=Video Channel 
This is the description that will be given to the channel.  This defaults to Desc. 

InsertAt=3 
This is the location in the list of markers at which the marker will be inserted.  If this 
line is not present the marker will be inserted at the end. 

ValueType=Scaled| Unscaled 
This is the type of data that you have specified in the value fields.  This defaults to 
unscaled values. 

ValueX=x 
This is the value that will be used to fill the X coordinates. 

ValueY=y 
This is the value that will be used to fill the Y coordinates. 

ValueZ=z 
This is the value that will be used to fill the Z coordinates. 

Delete a Marker 
This allows you to delete a 3D marker. 

To delete a 3D marker 
Type=Video 
Command=Delete 
Channel=3 

Type= Video specify that a 3d marker will be acted upon 

Command=Delete tells the application to delete a marker. 

Channel=N 
This is a 1-based number of the marker to be deleted. 
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Filter 3D Data 
This can be used to Filter the 3D data. Similar to the menu command Filter 3D 
command (Tools menu) 

To Filter All 3D Data 
 
[OperationN] 
Type=FilterVideo 
ZeroResidual = TRUE 
Command= FIR,LPF,10,0,21,All 

To Filter Selected frames of 3D data 
 
[OperationN] 
Type=FilterVideo 
ZeroResidual = TRUE 
Command= FIR,LPF,10,0,21,Selection 
Frames=80,100 

To Filter 3D data based on Residual 
 
[OperationN] 
Type=FilterVideo 
ZeroResidual = TRUE 
Command= FIR,LPF,10,0,21,Residual 
Residual=2.5 

Type=FilterVideo defines that the 3D data is filtered. 

ZeroResidual = TRUE clears the residual for each filtered point.  This may also be set 
to FALSE to leave the residual unchanged. 

Command = Filter, Type, Low Freq, High Freq, Order, Data. 
This is the Filter command line where, 

Filter is the name of the filter and can be set to FIR or Butterworth. 

Type the class of filtering desired which must be set to LPF, HPF, BPF or BSF (Low 
Pass, High Pass, Band Pass, and Band Stop). 

Low Freq is the lower band frequency. 

High Freq is the upper band frequency. 

Order is the Order of the filter. 

Data is the manner in which the frames to be filtered should be selected. This can be 
All, Selection or Residual. 

Frames = StartFrame, EndFrame is needed if the Data field in the Command entry 
was set to Selection. This allows you set the range of frames for filtering the data. 
Start Frame is the frame from which filtering will start while End Frame is the frame 
at which filtering will stop. 

Residual = ResidValue is needed if the Data field in the Command was set to 
Residual. This allows you specify ResidValue, a value above which the 3D data will 
be filtered. 
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Change Sample Rates 
The sampling frequency of the analog data can be changed by modifying the analog 
to video ratio. 

The sampling frequency of both the analog and 3D data can also be changed by 
changing the base sampling frequency of the data since the analog to video ratio is 
calculated in relation to this sample rate. 

To Change Analog to Video Ratio  
 
[OperationN] 
Type=SamplingFreq 
Command=AV,5 

This example batch script changes the Analog to Video ratio to 5 analog samples per 
video sample.  

To Change Base Frequency 
 
[OperationN] 
Type=SamplingFreq 
Command=Base,30 

This example script changes the base video sample frequency of the 3D data to 30 
samples per second or 30 Hz.  

Type=SamplingFreq states that this type of command will change the sampling 
frequency of the data. 

Command = Type, value controls the operation where Type is the type of frequency 
change necessary. It can be set to AV or Base where AV will change the analog to 
video ratio and will affect the sampling rate of only the analog data. Base will change 
the video sampling rate, which affects the sampling frequency of both the analog and 
3D data. Value is the new value for the selected sample rate. 

Interpolate data 
This batch command can be used to automatically interpolate the 3D data present in 
the C3D file. Its operation is identical to the manual interpolation command that is 
available from the Tools menu. 

Interpolate 3D Data using Gaps 
 
[OperationN] 
Type=Interpolation 
Command=Gaps,5 

This example interpolates 3D data to fill all gaps greater than 5 samples. 

Interpolate 3D Data using Residual 
 
[OperationN] 
Type=Interpolation 
Command=Residual,2.5 

This example script interpolates the 3D data to replace all trajectories that have a 
residual value greater than 2.5. 
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Type=Interpolation define this as a command that will interpolate data. 

Command = Type, value controls interpolation command where Type is the type of 
interpolation to be carried out. It can be set to Gaps or Residual.  

• Gaps implies that the 3D data will be interpolated if the gap in the data 
is greater than the value. 

• Residual implies that the 3D data will be interpolated if the residual 
exceeds the value specified. 

Create, Modify or Delete Groups 
The C3Deditor batch mode makes it very easy to Create, Modify or Delete groups 
whenever a C3D file is opened. This is an easy way to add a new group together with 
parameters to any C3D file. The following examples demonstrate the creation, 
modification and deletion of groups. First we create the group: 

Create 
 
[OperationN] 
Type=Group 
Command=Create 
Name=SUBJECT 
Description=Test subject information 
Number=-11 
Lock=0 

Or we can modify the group or any characteristic such as adding a new description or 
changing the name: 

Modify 
 
[OperationN] 
Type=Group 
Command=Modify 
Name=POINT 
NewName=NEWPOINT 
Description=Modified POINT group 
Number=-12 
Lock=1 

And finally – unwanted groups (complete with parameters) can be deleted when they 
are no longer used: 

Delete 
 
[OperationN] 
Type=Group 
Command=Delete 
Name=OLDSUBJECT 

The group commands are: 

Type=Group – this defines this as an operation is to be carried out on a Group. 

Command=Create | Modify | Delete – this defines the operation as create, modify, or 
delete as desired. 

Name= - this is the name of the group to be created, modified or deleted. 
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NewName= is applicable only if the group is being modified and defines the new 
name that the group will be given. If this entry is not present then the original group 
name will be retained. 

Description= is the description of the group to be created or modified. If this entry is 
not present the description will be blank. If you are modifying a group and do not 
include this line then the group will use the original description. 

Number= defines the number of the group which must be unique. This parameter is 
optional and if it is not specified then the first available group number will be used.  
If a group is being modified then the old number will be used if no new number is 
specified. 

Lock=0 | 1 - sets the status of the group. If this is not present, the group status will be 
unlocked. A value of 0 set the group unlocked while any other value locks the group. 

Create, Modify or Delete Parameters 
The C3Deditor batch mode makes it very easy to create, modify or 
delete parameters within groups whenever a C3D file is opened. This 
is an easy way to add a new parameter, or group of parameters, to any 
C3D file. 

The C3Deditor installation 
will install sample batch 
files that demonstrate 
common editing tasks. 

In addition, existing parameters can be modified making it easy to update the value 
of a parameter to correct errors in such items as force plate positions or scaling 
factors.  

Some programs, such as MOVE3D (available from the NIH in Bethesda, MD) 
require specific parameters before data can be analyzed. The C3Deditor provides an 
easy way to create and modify parameters under these circumstances. 

It is strongly recommended that anyone using the C3Deditor to create, 
modify or delete C3D parameters should read the C3D file 
specification first. It is vitally important that users take the time to 
thoroughly understand the consequences of any proposed changes 
before they use the C3Deditor to make changes to the C3D file 
parameters. Deleting or modifying a critical parameter can destroy the 
integrity of 3D and analog data within the C3D file. 

We recommend that the 
C3Deditor should not be 
used to change the status or 
values of locked parameters.  

The following examples demonstrate the creation, modification and deletion of 
parameters. First we create the parameter:  

Create 
 
[OperationN] 
Type=Parameter 
Command=Create 
Group=Analog 
Name=Temp 
Description=Temp Param 
Lock=0 
DataType= -1 
Dimensions=3 
Dimension1=5 
Dimension2=2 
Dimension3=3 
Data1=Data1 
Data2=Data2 
Data3=Data3 
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Data4=Data4 
Data5=Data5 
Data6=Data6 

Modify 
 
[OperationN] 
Type=Parameter 
Command=Modify 
Group=Analog 
Name=Temp 
NewGroup=Point 
NewName=TempMod 
Description=Modified Temp 
Lock=0 
DataType=4 

Delete 
 
[OperationN] 
Type=Parameter 
Command=Delete 
Group=Point 
Name=TempMod 

Type=Parameter - This defines the operation as a parameter operation. 

Command=Create | Modify | Delete – defines the parameter operation as one that will 
create, modify, or delete a parameter. 

Name Defines the parameter name that will be created, modified or deleted. 

Group This specifies the group that owns the parameter (parameter names are not 
required to be unique). 

NewName is only required if the parameter name is being modified and supplies the 
new parameter name. If this entry is not present then the parameter name will not be 
changed. 

NewGroup is only required if the parameter is being modified by moving it to a 
different group. It specifies the new group name. If this entry is not present then the 
modified parameter will belong to the same group as the old parameter. 

Lock= 0 | 1- sets the status of the Parameter. If this is not present, the parameter will 
be created as an unlocked or will be unchanged. A value of 0 defines the parameter 
as unlocked while any other value locks the parameter. 

DataType= -1 | 1 | 2 | 4 – this defines the type of data contained in the parameter 
and can have the following values: 

• -1 (Character data type) 

•  1 (Boolean data type) 

•  2 (Integer data type) 

•  4 (Floating Point data type) 

If the parameter is being modified and the DataType is not specified then the data 
type of the original parameter will be retained. 

The C3Deditor User Guide C3Deditor Files  •  113 



 

Dimensions – this defines the number of parameter dimensions. Note that if the data 
type is Char then it must have at least one dimension. If the operation is modifying 
the parameter and this entry is not present, then the original parameter dimensions 
will be unchanged. 

DimensionN – this is the value of a specific dimension (N). If the operation is 
modifying the parameter and this entry is not present then the original parameter 
dimension values will be retained. 

DataN – this is the value of a specific (N) data item. There should be 
as many DataN entries as there are data items (the data length is the 
product of the dimensions).  

For the data type Char, the 
data length is the product of 
all the dimensions except 
the first. This is because the 
first dimension gives the 
number of characters in 
each item. 

Zero the Force Plate channel 
This can be used to remove any drift in the baseline of the force plate channels.  See 
the command Zero FP channels (see Error! Bookmark not defined.) to see the 
process that is carried out. 

To zero FP channels 
[Operation1] 

Type=ZeroFP 

FP=2 

Type=ZeroFP tells the application to remove the baseline drift from the FP Channels. 

FP=ALL|1,2 
This tells the application which force plates should have the baseline fixed.  This can 
be ALL in which case all force plates will be acted upon or you have have the 1-
based force plate numbers separated by commas. 

Validity File Format 
The Validity check is controlled by the validity file. This is a text file which contains 
a definition of the characteristics of the parameters that you use.  You may find that 
you need to create several different formats – the C3Deditor will use the file 
specified in the General Page using the Options command (Tools menu). 

The Validity file contains a list of the groups that should be present in the C3D file. 
This should be presented as shown below: 

 
[Groups] 
Number=4 
Group1=Analog 
Group2=Point 
Group3=Seg 
Group4=Force_Platform 

The format for entries that are required for each parameter that should be present in 
the C3D file is: 
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[ParameterName-GroupName] – This is the name of the parameter and the group that 
it belongs to, separated by a dash. 

DataType – This is the type of data expected in the parameter that is to be validated.  
It should have one of the following values: 

–1 (CHARACTER data type) 

1 (BOOLEAN data type) 

2 (INTEGER data type) 

4  (FLOATING POINT data type) 

NumberOfDimensions – This is the number of dimensions expected and can have a 
value between 0 and 7. 

DimN – DimN can have values from 1 to 7 depending on the number of dimensions. 
If the parameter contains scalar data, there will be no dimensions and there will be 
no DimN entries. 

For example: 

 
[Used-Point] 
Data=2 
NumDim=0 
 
[Data_Limits-Seg] 
Data=4 
NumDim=2 
Dim1=3 
Dim2=2 
 
[LABELS-Point] 
Data=-1 
NumDim=2 
Dim1=4 
Dim2=40 
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